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Nataly Kelly is the director of product
development with NetworkOmni
Multilingual Communications. She is also a
certified court interpreter (State of
Missouri) for English and Spanish. A
former Fulbright scholar in sociolinguistics,
her current research interests are interpreter certification, quality improvement
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National Council on Interpreting in Health Care’s Outreach Committee.
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over 20 years. She is a member of the
International Association of Conference
Interpreters and a former member of the
Judicial Council of California Court
Interpreters Advisory Panel. She has also
interpreted during the post-medal press
conferences for three Olympic games (Atlanta, Sydney, and Salt Lake
City). She is currently serving on ATA’s Board of Directors. Contact:
jacki@transkorean.com.

Tuomas Kostiainen is an ATA-certified
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current president of the Northern
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translator. She teaches interpretation and translation in the Graduate
School of Translation and Interpretation at the Monterey Institute of
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translation and intercultural studies at the Universitat Rovira i Virgili in
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Ne’eman Hebrew Language Services, Inc.
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prime ministers, major television networks,
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It’s
Time
To Renew

Guide to ATA

Continuing Education Points
Visit www.atanet.org
(click on certification)

If you have not renewed your membership,
now is the time!
From membership in any or all of ATA’s 15 divisions—
including the new Language Technology and Korean
Language Divisions—to discounted business services,
ATA gives you the strategic edge that benefits
your bottom line.

Renew online at:
www.atanet.org/membership/renew.php
Thank you for your past support and for renewing for 2007.
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NATIONAL SECURITY AGENCY

NSA

D O Y O U S P E A K T H E L A NG U A GE W E N E E D T H E MO S T ?
Understanding the world and its many languages is what helps NSA solve the Nation's most
difficult challenges.
As a Language Analyst with NSA, your language proficiency and the understanding of nuance,
context, cultural overtones, and dialect will have a global impact in providing the fullest and
most accurate intelligence to U.S. policymakers, military commanders, and Intelligence
Community members.
If you're ready for the responsibility, join NSA, and secure tomorrow today.
NSA has a critical need for individuals with the following language capabilities:
> A ra bi c
> C h i n es e
> Fa rs i
> K o r ea n
For a complete list of languages or to apply online,
visit our Web site.
U.S. citizenship is required. NSA is an equal opportunity employer.
All applicants for employment are considered without regard to
race, color, religion, sex, national origin, age, marital status,
disability, sexual orientation, or status as a parent.

www.N S A .gov/Careers
W H E R E IN T E LLIGE NC E GOE S TO W OR K

From the Executive Director

Walter Bacak, CAE
Walter@atanet.org

Conference Recap and More

This edition of The ATA
Chronicle offers highlights from the
47th Annual Conference. Of particular
note, Jeff Sanfacon, editor of The ATA
Chronicle, and ATA Member Alzi
Platts captured many of the sights of
the conference. Some of their outstanding photos are published in this

Orleans were just happy to have ATA’s
business, the donation to Habitat for
Humanity was a great gesture by the
Association to help the city further
and a nice complement to ATA’s pro
bono work in New Orleans (see
October issue, page 40).
Finally, if you attended the conference and have not completed a confer-

I am pleased to report that the sales [of the conference
t-shirts] resulted in ATA donating $1,575 to the New
Orleans Area Habitat for Humanity to support their
efforts to rebuild New Orleans.
issue on page 40. You can check out
all their photos online at www.
atanet.org/conf/2006/photo.
If you missed the conference, you
can still listen to most of the conference educational sessions and read the
handouts by ordering the conference
DVD. The breadth and depth of translation and interpreting knowledge
shared at this one event is unmatched
in the profession. To order a copy,
please go to www.atanet.org/conf
/2006. Listening to the DVD will also
earn 10 Certification Continuing
Education points.
Besides once again thanking the
nearly 1,300 attendees, I also want to
thank those who purchased special
conference t-shirts. A portion of the
proceeds of the sales went to the New
Orleans Area Habitat for Humanity to
support their efforts to rebuild New
Orleans. I am pleased to report that
the sales resulted in ATA donating
$1,575. While the folks in New

8

ence evaluation form, please do. The
form is available at www.atanet.org/
docs/evaluation_form_confer
ence_2006.pdf. The feedback from
attendees is incredibly important to
help us build upon the success of the
previous year. For example, looking
ahead to next year’s conference in San
Francisco, we are already acting on
some of the preliminary feedback:
reduce the number of preconference
seminars; offer more advanced sessions (which is always a challenge
because of the limited pool of presenters); watch that popular sessions
repeated from previous years offer
updated material; and schedule more
time for the presentation of candidates
and election.
ATA Membership Renewal: If you
have not renewed your membership,
please do. From membership in any or
all of ATA’s 15 divisions—including
the new Language Technology and

Korean Language Divisions—to discounted business services, ATA gives
you the strategic edge that benefits
your bottom line. You may renew
online at www.atanet.org/member
ship/renew.php. Thank you for your
past support and for renewing for
2007.
Reminder for ATA-Certified Translators: For those members who passed
ATA’s certification exam prior to
January 2004, just a reminder that
your first continuing education points
report is due. For more information,
please read the Certification Forum on
page 44.
Next Board Meeting Scheduled: The
next Board of Directors meeting is set
for January 27-28, 2007 in Boston.
The minutes of the meeting will be
posted online at www.atanet.org/mem
bership/minutes.php. Past meeting
minutes are also posted on the site. As
always, the meeting is open to all
members.
The meeting will be preceded by
the Board’s Annual Governance
Review. The Board will take a
strategic look at the Association—
where we are and where we want to
be. Prior to last year’s planning day,
the Board had held this review every
other year—during the first year of the
new ATA president’s term. However,
the Board felt the planning session
provided so much valuable information that it should be conducted annually. The core developments from this
one-day event will be published in
The ATA Chronicle and used as the
foundation for the Association’s
efforts throughout the year.
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Is it time
to sell your business?
Take this quiz:
Has your heart rate increased?
Are clients demanding FIGS at 3¢ a word?
zHave TM, CMS and GMS expenses maxed out
your credit card?
zVacation? What vacation?
z
z

If you answered "yes" to any of these
questions, then it's time to think about selling.
Local Concept is actively seeking to acquire
select translation/localization companies.

Call Michael Cárdenas, President, for a confidential discussion.
+1.619.295.2682
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2006 Honors and Awards Winners
Alexander Gode Medal
Peter Less
The Alexander Gode Medal, ATA’s most prestigious award, is
presented to an individual or institution for outstanding service to
the translating and interpreting professions. ATA is proud to recognize Peter Less as the recipient of the 2006 Alexander Gode
Medal for his pioneering service at the Nuremberg Trials.
A native of Germany, Peter fled Nazi Germany and attended
the Geneva School of Conference Interpretation in Switzerland,
becoming one of its first graduates. In 1946, Peter, then 25, was
recruited by the U.S. Army to provide interpreting services
during the Nuremberg Trials. He interpreted the proceedings
simultaneously in the courtroom, and consecutively during depositions. He also translated court documents as well as the final
judgment. Nuremberg was one of the first times a multilingual
event was interpreted using the simultaneous mode (with primitive interpretation equipment, including bolted-down microphones and heavy headsets).
Peter, who lost his entire family to the Nazi regime, sat in the courtroom a few feet from Hermann Goering,
Rudolf Hess, and others accused of crimes against humanity. Following the trial, Peter moved to the U.S. He is a
family law attorney in Chicago.
In the September 2004 issue of The ATA Chronicle, Peter reflected upon his role at these historic trials. The following
are a few of his comments:
“I enrolled in the Faculté des Lettres and got my university
degree. Attached to the University of Geneva was the École
d’Interprètes, which trained interpreters. I spoke German, English,
and French, and I enrolled there. It was a two-year course. At first,
they would speak very slowly, accentuating
every syllable: ‘Heute ist das Wetter sehr
schoen.’ (‘Today the weather is very nice’).
After a few weeks, they would speak quickly
and with an accent.
There were about 15 or 18 students in my
class. We graduated shortly after WWII
ended. At that time, the Americans, the
British, the Russians, and the French were
organizing an international war crimes triATA President Marian S. Greenfield congratulates Peter Less at ATA’s Annual Conference in New Orleans.
bunal. One day, American officers in uniform came to the school. They tested a
dozen people and hired a handful, including me. ‘Tomorrow morning,’ the American officer said, ‘you must fly to
Nuremberg.’
It wasn’t easy. You were sitting in the same room with the people who probably killed your parents, but you could
not let your feelings interfere with your job. You swore to interpret as faithfully as possible, to put the speaker’s idea
into the listener’s head. So we did.”
The Alexander Gode Medal is named for ATA’s founder and guiding spirit, who was the first recipient. The medalists represent a record of achievement in a variety of venues, including not only translators and interpreters, but lexicographers, theorists, association leaders, and institutions. This award may be given annually.
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Alicia Gordon Award for Word Artistry in Translation
Liliana Valenzuela
The inaugural Alicia Gordon Award for Word Artistry in Translation was presented to Liliana
Valenzuela for her Spanish translation of an excerpt of the novel ¡Caramba!: A Tale Told in Turns of the
Card, by Nina Marie Martínez (Alfred A. Knopf, 2004). Liliana’s Spanish translation of the novel,
¡Caramba!: Una historia narrada al azar de las cartas, was published in 2006 (Vintage Español,
Random House).
The following are Liliana Valenzuela’s comments about how she selected the award-winning entry.
“I knew the paragraph I wanted to submit for the award would come from the chapter entitled ‘The
Lord’s Work.’ This paragraph has a very interesting structure, composed of two very long sentences, broken up into smaller ones. But more importantly, the author and
I had come up with a very original and Mexican way of conveying the
meaning of “attitude” at the end. I am indebted to her for challenging me
to go beyond the conventional chingonería, which might have worked,
and coming up with an even better one, a neologism: chingonalidad,
describing the state or quality of being a chingón. For Mexicans or anyone
familiar with Mexican slang, this needs no further explanation.
What I didn’t know, until after receiving the award, is that this particular paragraph had originally occurred to the author as a sound, with no
words. She heard the rhythm and then filled in the words. Later, she realized that the sound
came from The House that Jack Built, a traditional children’s rhyme, illustrated by various artists
in its many renditions as a children’s book. And when she said it, while we were doing a bilingual
reading at the St. Paul Public Library, I realized that it was true. The cadence was the same.
Perhaps it is this quality that first attracted me to this opening paragraph. Funny how art works!”
The Alicia Gordon Award for Word Artistry in Translation was established in memory of Alicia
Gordon, known for creating imaginative solutions to knotty translation problems, based on rigorous research. It is not just for literary translators, but recognizes outstanding legal, technical,
and commercial translation of all kinds. The award was established by Alicia’s sister, Dr. Jane
Gordon, and the award fund is administered by the American Foundation for Translation and
Interpretation (www.afti.org).

Lewis Galantière Award
Geoffrey Brock
Geoffrey Brock is the recipient of the 2006 Lewis Galantière Award for his translation of Umberto Eco’s most recent novel, The Mysterious Flame of Queen Loana
(Harcourt, June 2005).
Geoffrey was born in Atlanta, Georgia, in 1964. He earned an MFA in poetry from
the University of Florida and a Ph.D. in comparative literature from the University of
Pennsylvania.
Geoffrey’s first book of poems, Weighing Light, received the New Criterion Poetry
Prize and was published in 2005 by Ivan R. Dee. His poems have appeared in journals
including Poetry, Paris Review, PN Review, New England Review, and Hudson Review,
as well as in several anthologies. Geoffrey has received fellowships for his poetry from
the National Endowment for the Arts, The American Antiquarian Society, the Arizona

➡
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2006 Honors and Awards Winners Continued

Commission on the Arts, and the Florida Arts Council. He was also a Wallace Stegner Fellow in poetry from 2002-2004.
In 1998, Geoffrey was awarded the Academy of American Poets’ Raiziss/de Palchi Translation Fellowship, which allowed
him to complete his translation of Cesare Pavese’s Disaffections: Complete Poems 1930-1950, which was named a “Best
Book of 2003” by the Los Angeles Times. He is also the translator of Roberto Calasso’s book about Franz Kafka, K., and a
new novel about the Armenian genocide, Skylark Farm, by Antonia Arslan. His translations have received Poetry’s John
Frederick Nims Memorial Prize, the PEN Center USA Translation Award, the Modern Language Association’s Lois Roth
Award, and the Italian Ministry of Foreign Affairs Translation Prize.
Geoffrey is currently working on his second manuscript of poems and, with the support of the Guggenheim Foundation,
compiling a bilingual anthology of 20th-century Italian poetry, which will be published by Farrar Straus & Giroux. He
teaches in the Programs in Creative Writing and Translation at the University of Arkansas in Fayetteville.
The Lewis Galantière Award is bestowed biennially in even-numbered years for a distinguished book-length literary translation from any language, except German, into English. This award honors distinguished ATA founding member Lewis
Galantière (1894-1977). His translations from French drama, fiction, poetry, and scholarship enriched cultural life during the
middle decades of the 20th century, and are still being read over a quarter century after his death.

See page 57 for the 2007 Honors and Awards guidelines.

Congratulations Rosario Welle!
Winner of ATA’s 2006 School
Outreach Contest
Rosario Welle received free registration to ATA’s
2006 Annual Conference in New Orleans for the
photo she took of her School Outreach presentation
to the first grade at Florence Black Elementary
School in Mesquite, Texas. To demonstrate the lifesaving power of language skills, Rosario and three
students dramatized a 911 call, with the children
playing the roles of an injured person, an interpreter, and a dispatcher. Rosario is a full-time
translator/interpreter
with
the
Mesquite
Independent School District and a tireless volunteer, using her language skills to benefit her
church and the local community.

’s Annual Conference.
ing her award at ATA
Rosario Welle receiv

12

Enter to win free registration to ATA’s Annual
Conference in San Francisco, October 31November 3, 2007. For information, go to
www.atanet.org and click on Careers.
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Address your letters to Jeff Sanfacon at
jeff@atanet.org or American Translators
Association, 225 Reinekers Lane, Suite 590,
Alexandria, VA 22314.

Letter to the Editor

Translation Office 3000: A Tool for the Freelance Translator

After reading Dorothee

Racette’s excellent article, “Improving
the Organization and Workflow of
Your Freelance Business” in the
September issue, I just had to write
and add a short review on what I consider my best investment as a freelance translator.
I am referring to Translation Office
3000 (www.translation3000.com), an
accounting software tool designed for
freelance translators. This software
costs €159, but the website offers a
free 30-day trial download.
I have used this program for the
past three years, and I could not do
without it. When you receive an order,
all you do is enter the job number,
purchase order number, deadline,
word count, and rate in the system.
That’s it. The job schedule shows all
current jobs, with different colors
noting priority.
When a job is completed, an invoice
is created with one click of the mouse

and saved in a file of your choice.
Upon payment receipt, enter it next to
the corresponding invoice. Overdue
invoices appear in red and outstanding
invoices appear in green, with the
expected payment date for each one.
The program automatically creates
various reports, including monthly
sales, service breakdown, top 10
clients (which is very interesting for
purposes of client diversification).
Year after year, the reports give you a
very clear picture of your business and
its growth.
The program accepts different currencies for different clients, which
enables you to send an invoice in
euros, for instance, while the reports
convert everything into your base currency, so you have an accurate status
of your business at all times.
For me, invoice creation is no
hassle: I probably spend 10 minutes at
the end of each month on this, and that
is all!
There are many other features, but

perhaps the most important thing, to
me at least, is that this program is very
user-friendly. It allows you to keep
track of everything without the risk of
forgetting a job or missing a deadline.
When multiple jobs land in your
mailbox on the same morning, all you
do is enter each one in the system and
you can instantly see what you have to
do and in what order.
I am sure there are other programs
like this one, although I cannot say I
have tried or compared any of them.
This piece of software is doing everything I need!
Please note that I am not an
employee of the software manufacturer, nor am I benefiting in any way
from this review. I just wanted to
share my experience with others.
Marguerite Storm
Amarillo, Texas

American Translators Association

48th Annual Conference Call for Papers
San Francisco, California

•

October 31-November 3, 2007

Proposals are invited on topics in all areas of translation and interpreting, including the following:
Agencies, Bureaus, and Companies; Financial Translation and Interpreting; Independent
Contractors; Interpreting; Language-Specific Sessions; Legal Translation and Interpreting; Literary;
Medical Translation and Interpreting; Scientific and Technology; Social Sciences; Terminology;
Training and Pedagogy; Translators and Computers. Suggestions for additional topics are welcome.
Proposals for sessions must be submitted on the Conference Presentation Proposal Form to:
Conference Organizer, ATA Headquarters, 225 Reinekers Lane, Suite 590, Alexandria, VA 22314;
Fax: (703) 683-6122. All proposals for sessions must be in English.

Submission deadline: March 9, 2007
There’s no time like the present! Download a Conference Presentation Proposal Form at
www.atanet.org/conf/2007/abstract.pdf.
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Nisei Linguists During WWII
and the Occupation of Japan
By Kayoko Takeda

During World War II and the occupa-

tion of Japan, Nisei (second-generation Japanese
Americans) played crucial roles as translators,
interpreters, and interrogators, and served in other
important language-related functions. Since they
worked in military intelligence, their contributions were not discussed in much detail until the
early 1970s, when a number of intelligence documents were declassified. This article presents an
overview of the recruitment and activities of these
Nisei linguists.

The U.S. Army’s Japanese Language School:
Before and After Pearl Harbor
Prior to Pearl Harbor, a division of the U.S.
Army on the West Coast started a classified military intelligence training program for personnel
with Japanese language skills in preparation for
an anticipated war with Japan. This classified program, based in the Presidio of San Francisco,
began operation on November 1, 1941, with four
Japanese American teachers and 60 students (58

Given the proven value of
Japanese linguists in various fields
of operation, the U.S. government
started recruiting hundreds of
Nisei from the internment camps
to train at MISLS.
Nisei and 2 Caucasians). After six months of
intensive training, most of the 45 graduates were
sent to various military fields of operation to work
in intelligence.
Soon after Japan’s attack on Pearl Harbor on
December 7, 1941, all Japanese Americans were
reclassified as 4-C (enemy aliens who were ineligible for military service). In February 1942, U.S.
President Franklin Roosevelt signed Executive
Order 9066, which resulted in the forced relocation
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of nearly 120,000 Japanese and
Japanese Americans on the West Coast
to internment camps. As a result, the
U.S. Army’s Japanese military intelligence training program moved to
Minnesota in late May of 1942.
By that time, the valuable contributions being made by the first graduates
of the program had been reported back
from the war front. The Army was also
becoming acutely aware of the need
for more Nisei linguists for military
intelligence. The program was reorganized under the direct supervision of
the War Department, and reopened on
June 1, 1942 as the Military Intelligence Service Language School
(MISLS). Given the proven value of
Japanese linguists in various fields of
operation, the U.S. government started
recruiting hundreds of Nisei from the
internment camps to train at MISLS.
Finding qualified Nisei, however, was
a challenging task. According to Bill
Hosokawa: “[o]f the first 3,700 men
interviewed, only 3% proved to speak
Japanese fluently. The next 4% could
be considered fairly proficient in the
language. Another 3% knew just
enough so that they could be thrown
into intensive training; only 1 Nisei in
10 understood a useful amount of his
ancestral tongue. And even the best of
them had to be taught military vocabulary and usage.”1

Translation and Interrogation
More than 6,000 Nisei received six
months of rigorous training at MISLS,
after which they were sent mainly to the
Pacific military operational theater.
They served in the Allied Translator and
Interpreter Service (ATIS) and in other
units as translators, interpreters, interrogators, code breakers, and “cave
flushers.” Some of these individuals
were “loaned” to the U.S. Navy, since it
did not accept Nisei enlistments. (The
Navy had its own Japanese language

The ATA Chronicle

■

January 2007

schools just for Caucasian officers, but
they did not produce many competent
linguists.)

men and to their families which it
can never fully repay.”3

Prior to Pearl Harbor, a division of the U.S. Army on
the West Coast started a classified military intelligence
training program for personnel with Japanese language
skills in preparation for an anticipated war with Japan.
Nisei linguists translated captured
enemy
documents,
interrogated
Japanese prisoners of war, persuaded
Japanese soldiers and civilians to surrender, and participated in propaganda
activities. One of the most vital tasks
they engaged in for the U.S. military
was the translation of Japan’s “Z
Plan,” which called for a Japanese
counterattack in the Pacific. The
knowledge obtained through the translation of these intercepted documents
led to a significant victory for U.S.
forces. This is considered by historians to be “one of the greatest single
intelligence feats of the war in the
Southwest Pacific Area.”2
Nisei linguists earned much recognition for their valuable contributions
to the war effort. Colonel Mashibir,
the ATIS commander, wrote in his
autobiography:
“Had it not been for the loyalty,
fidelity, patriotism, and ability of
these American Nisei, that part of
the war in the Pacific, which was
dependent upon intelligence
gleaned from captured documents
and prisoners of war, would have
been a far more hazardous, longdrawn-out affair. The United States
of America owes a debt to these

According to a 1945 report, the Nisei
linguists had translated 20.5 million
pages by the end of the war.

War Crimes Trials and Occupation
Nisei linguists were also indispensable during the occupation of Japan.
The enrollment at MISLS actually
peaked after the war in response to the
need to address the language needs of
various operations of the occupation.
The focus of instruction shifted from
military to civilian language and
Japanese culture.
More than 5,000 Nisei linguists
worked in occupied Japan, functioning
as a “bridge” between the occupation
forces and Japanese authorities and
civilians. Their duties covered a variety
of areas, including intelligence, disarmament, civil affairs, education, and
finance. They even participated in the
drafting of the Japanese Constitution
and the formation of the National
Police Reserve (which later became
the Japanese Self-Defense Force).
Nisei linguists also provided translation services for Japanese war
crimes trials. Some worked as interpreters at Class B/C war crimes trials,
such as those in Manila and
Yokohama. (There were three categories of war crimes: “Class A” ➡
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Nisei Linguists During WWII and the Occupation of Japan Continued

for crimes against peace, “Class B”
for war crimes, and “Class C” for
crimes against humanity.) At the
International Military Tribunal for the
Far East (IMTFE), a Class A trial,
four Nisei linguists worked as monitors to check the performance of the
interpreters (who were Japanese
diplomats and other Japanese

internment camp to teach at MISLS,
and later worked in military intelligence during the war. He broke coded
conversations (spoken in the dialect
of the region where he grew up)
between Japanese government officials. For this and many other intelligence activities he received the
Legion of Merit, the highest medal

According to a 1945 report, the Nisei linguists had
translated 20.5 million pages by the end of the war.
nationals). These Nisei monitors also
simultaneously read the translations
of the closing statements, the judgment (verdict), and other prepared
statements as they were delivered by
the prosecutors, defense counsel, and
the president of the tribunal.

Overcoming Prejudice
Along with many other Japanese
Americans, Nisei linguists lived
through the prejudice and discrimination directed toward them in the 1930s
and 1940s. In the midst of the war
hysteria and the fierce hatred against
Japanese Americans, they were sent to
internment camps as “enemy aliens.”
Kibei (Nisei who received an education in Japan and returned to the U.S.)
suffered even greater prejudice than
other Japanese Americans, as they
were suspected of being disloyal and
“pro-Japanese.” Ironically, Kibei were
the best source of military linguists
because of their prior education and
experience in Japan.
One of the most documented figures of all Nisei linguists, David
Akira Itami, was Kibei. Itami served
as the leader of the monitor team at
the IMTFE. He volunteered from an
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awarded to noncombatants. After the
IMTFE, Itami stayed on at ATIS as a
translator until 1950, when, at age 39,
he shot and killed himself. His family
and friends point to the prejudice
Itami experienced as an Asian in
American society and as Kibei in the
Nisei community, and cite the emotional strains he suffered during the

IMTFE as one of the reasons for his
suicide.
Even within the U.S. Army, Nisei
linguists had to fight prejudice and
suspicions of disloyalty while they
served in the Pacific. Although a
number of testimonials by Nisei linguists show their pride in having
proved their loyalty to the U.S., they
also discuss their complex feelings
about being sent to internment camps
by the same government that later took
advantage of their language skills in
the war against the country of their
parents. During my research, one of
those I interviewed talked about the
resentment he felt when he was sent to
the Pacific from MISLS with a dog tag
bearing the address of the internment
camp where his parents were detained.
While trying to overcome prejudice
within the military they served, the
Nisei linguists also struggled with
issues of cultural identity as they
worked to win a war against people of
their own heritage. James McNaughton
provides the following insight into how

Further Reading
Discover Nikkei. Winning the Peace: Military
Intelligence Service Veterans and the Occupation of
Japan. www.discovernikkei.org.
Military Intelligence Service Resource Center.
www.njahs.org/misnorcal/resources/
resources_videos.htm.
Otake, Tomoko. “Between Two Worlds: Tried to the Limit
and Beyond.” The Japan Times (August 14, 2005).

The ATA Chronicle

■

January 2007

Today’s MISLS

Nisei interpreters assisting with an interrogation during World War II.
Images courtesy of the Hirasaki National Resource Center, Japanese American National Museum, Los Angeles, California.

the Nisei linguists may have viewed
their opponents, the Japanese:
“At a deeper level of analysis, for
those who joined the Military
Intelligence Service to become linguists, the way they served was

guage was a major challenge
involving six months of hard work,
the knowledge and appreciation of
Japanese culture and society they
had absorbed from their parents
and upbringing gave them a unique
perspective on the enemy they

One of the most vital tasks they engaged in was the
translation of Japan’s “Z Plan” for the U.S. Navy.
more specific to their heritage, and
thus psychologically more complex. Whether translating captured
diaries or radio messages, or interrogating prisoners of war, they had
to confront issues of identity and
heritage in ways that most other
American soldiers could not even
imagine. Although for most of
them, learning the Japanese lan-

The ATA Chronicle

■

January 2007

faced. They had a capacity, all too
rare at that time, for seeing their
opponents as human beings, rather
than animals.”4
This complex psychological aspect of
military linguists fighting an enemy
closely linked to their own heritage
seems relevant in the context of
today’s war on terrorism as well.

In 1946, MISLS moved to the
Presidio of Monterey, California, and
was renamed the Army Language
School. In the midst of the Cold War,
the school mainly trained military linguists in Russian, Chinese, Korean,
and German languages. In 1963, the
school and the language programs in
the U.S. Air Force and Navy were
consolidated into the Defense Foreign
Language Program under the supervision of the Defense Language
Institute (DLI). Currently, the DLI
Foreign Language Center in Monterey
offers instruction in a number of languages to military personnel and
members of other federal agencies.
Arabic, Chinese, Korean, and Persian
Farsi are among the largest programs
at the moment.

Notes
1. Hosokawa, Bill. Nisei: The Quiet
Americans (Boulder, Colorado:
University of Colorado Press,
1969/2002), 397.
2. Bradsher, Greg. 2005. “The ‘Z Plan’
Story.” Prologue 37-3 (The U.S.
National Archives & Records Administration, 2005). www.archives.gov/
publications/prologue/2005/fall/
z-plan-1.html.
3. Hosokawa, Bill. Nisei: The Quiet
Americans (Boulder, Colorado:
University of Colorado Press,
1969/2002), 399.
4. McNaughton, James, C. Nisei
Linguists and New Perspectives on
the Pacific War: Intelligence, Race,
and Continuity (1994). www.army.
mil/CMH-PG/topics/apam/
Nisei.htm.
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Questions Are an Editor’s Best Friend
By Jacki Noh

When I launched my career

What are the source and
target languages of the
project?
What is the subject matter,
and can I see the source text?
What is the word count of
the source document?
When does the client need the
edited document back?
Can I see the translation?
Are there any reference
materials that were provided
to the translator?

What is the scope of the
editing job?
Am I being paid by the word
count or by the hour?
18

as a Korean/English translator and
editor in the mid 1980s, the market
was very small. Because of this, I
was afraid that if I asked questions of
my clients, I would be seen as
unqualified for the assignment or
labeled high maintenance. However,
reading Kurt Vonnegut’s Fates Worse
than Death changed my entire perspective on the subject. In his book,
Vonnegut talks about how he loves it
when translators of his books ask
numerous questions, since that
means the original flavor and intent
of his prose are probably going to be
properly conveyed in another language. Even though Vonnegut is
referring to translation, his advice
has given me the courage to ask my
clients questions in order to avoid
fiascos such as badly under quoting
an editing project and then having to
submit a higher invoice amount after
the project is delivered—definitely
not something that is particularly
comfortable to negotiate.
Accepting an editing project from

a translation project manager is a little
like finding a spouse by using what is
known as a Joong Mae Jang Yi (a
Korean matchmaker). Let’s look at the
similarities, shall we? (See Table 1.)
Just as you want to find out everything about a potential suitor before the
initial meeting, you also want to learn
everything there is to know about the
potential editing job before accepting
the assignment. The following are
some questions to ask and some points
to keep in mind to make sure you and
the job are a suitable match.

Determine if the Job “Fits”
Do you have the skills to edit the project?
Ask: What are the source and target
languages of the project?
This is an important question since
you should only edit in your native
language or another language strictly
equivalent to your native language.
Ask: What is the subject matter, and
can I see the source text?
I recommend not accepting any

Table 1
Project Manager/Editing Job

Matchmaker/Significant Other

• Sometimes information about the project
is vague.

• Sometimes information about your future
spouse is vague.

• The project manager’s job is to find an editor to
further refine the translation.

• The matchmaker’s job is to find a perfect
match to further enhance your romantic life.

• The project manager wants you to edit their job
so that it is complete.

• The matchmaker wants you to marry their
choice of a perfect match so that their job is
done.

END RESULT: As an editor, you must make sure
your questions are answered before jumping into
an editing project.

END RESULT: Unless divorce is a fun thing to
experience, you must make sure your questions
about your future spouse are answered before
jumping into matrimony.
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editing assignment where you are
unfamiliar with the subject matter.
Also, have the project manager send
you the source document so you can be
absolutely sure that the client’s
description of a simple “video game
proofreading job” actually matches
what you see. You do not want that
“light” proofreading job to turn into a

ences are an important factor to keep
in mind when deciding whether you
can deliver the job on time.
Ask: Can I see the translation?
Try to obtain either the translation
in its entirety, or at least a sample. If
you cannot see the translation before
accepting the job, try to get as much

Accepting an editing project from a project manager
is a little like finding a spouse using a matchmaker.
complex review of the technical
schematics of a Sony PlayStation.
Also, never assume that the person
whose translation you will be editing is
an expert in that field with years of
experience translating similar documents. If you do, you might be in for
an unpleasant surprise. Just remember
that the translator might have had the
same assumption about the editor
(you!) who was going to eventually
look the document over.
Can you do the job given the parameters
set by the project manager?
Ask: What is the word count of the
source document?
Can you edit 10,000 words of text in
24 hours? If you cannot, you might
want to turn down projects with unreasonable deadlines or those requiring
super-human editing skills to complete.
Ask: When does the client need the
edited document back?
This is a pretty obvious question,
but you need to make sure that when
the project manager says he needs it
back by the end of day, does that
mean the end of day in New York or
the end of day in Korea? Time differ-
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information about the translator as
possible from the project manager.
Has the project manager used the
translator before? Does the translator
have previous experience with the
subject matter? Having this information might give you at least an idea of
the quality of the translation you will
be receiving. Remember, the quality
of the translation will no doubt greatly
impact your ability to deliver on time.
Ask: What is the scope of the
editing job?
The answer to this question can
certainly determine how long it will
take you to edit the job. Sometimes
the project manager might say, “do
what it takes to make this a great
translation.” While this may seem like
something desirable, what the project
manager is saying is that you ultimately have the responsibility of
ensuring the final quality of the
product. Other times, the project manager will only want you to check for
obvious errors or omissions, which
will take considerably less time.
Do you have the right tools?
Ask: Are there any reference materials

that were provided to the translator?
Reference material could include
anything from a glossary to past translations that were approved by the end
client. The purpose of having access
to these materials is so that you will
not accidentally “correct” a term that
was actually provided by the client.
Also, you can edit the translation if
necessary to follow more closely the
writing style of previously approved
translations.
Request the translator’s guidelines
to make sure that they are followed
during the editing process. These
guidelines usually consist of some of
the following information:
• Target audience information (demographics such as age, education
level, and place of residence). This
information will help you determine
what register you choose to edit
toward (U.S. or overseas usage), the
terminology you use, and so forth.
For example, the word “mortgage”
must be transliterated for Korean
Americans living in the U.S.,
whereas the same word must be
translated for Koreans living in
Korea. Again, you want to edit
toward what the end client wants,
not away from it!
• The words or phrases that need to
be left in English and the ones that
should be translated with the
English in parenthesis.
Is the job worth your time?
Ask: Am I being paid by the word
count or by the hour?
This is certainly a loaded question.
If you charge by the word count, then
it is definitely a gamble if you accept
the job without seeing the translation.
Most editors set a word count rate
assuming the translation is of decent
quality and that they will be ➡
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Questions Are an Editor’s Best Friend Continued

able to edit a certain number of words
per hour. Will that rate per word you
quoted suffice if it turns out that the
translation is very sub-par? However,
charging by the hour can also have its
pitfalls. If you have the translation,
you can at least quote accurately to
the project manager so they can issue
their own quote to their client.
Otherwise, you will have to take your
best guess. Do you guess high and
possibly lose the job? Do you guess
low and risk not being reimbursed for
the time it really took to edit? It is
your choice depending upon the circumstances you face.

Once You Have Accepted the Job
• Keep a log
• Do a quick evaluation
• Let the project manager know if
there is a problem
• Put questions in writing

are sinking!” the novice sailor replied
in a thick accent, and with some trepidation, “…and…what are…you…
sinking about?” Hopefully you will
not encounter an editing job from
someone who is doing their very first
translation, but you never know!

Once You Have Accepted the Job
Keep a log: It is also a good idea to
maintain an editorial log containing all
the information that is relevant to the
project. More importantly, this log will
serve as a place for you to jot down
notes about your editing. For instance,
if there are incorrect word choices
used in the translation, write down

Let the project manager know if
there is a problem: If the translation
is so bad that it is beyond editing, contact the project manager as soon as
possible and offer a thorough translation assessment service for a set fee or
by the hour before turning down the
job completely. The project manager

It is a good idea to maintain an editorial log containing
all the information that is relevant to the project.
specific examples. Such a listing can
be helpful later on if the project manager asks you to provide evidence for
the poor quality of the translation.
Do a quick evaluation: If you did not
get the translation before you accepted
the project, do a quick evaluation of
the translation just to see what you are
dealing with. The Berlitz Language
School came up with a great commercial involving a member of the
German Coast Guard on his first day
on the job. Upon hearing a distress call
from an English speaker on another
ship who said “mayday, mayday, we
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might convince the end client to spend
the money to have the project retranslated. If the issues you encounter on a
project turn out to be beyond what you
and the project manager expected,
leave it up to the project manager to
decide how to proceed. Be sure to reevaluate the project yourself to make
sure you have the time to complete the
project, and that you will be reimbursed appropriately.
Put questions in writing: If you have
questions during the editing process, it
is always best to address them in
writing to your project manager.

Along with your questions, it is a good
idea to send a PDF file of the translation with your notes inserted next to
the text you have flagged (Adobe
offers a convenient Insert Notes function for this). This will allow the
project manager to better answer your
questions, because they will be able to
refer to the original text and easily see
your notes next to the highlighted text.

Know Your Limitations
An editor must know his limitations and when to say “no,” even
though it may be difficult to turn down
a job. But you need to think about how
to make this experience as pleasant
and successful as possible for you,
your reputation, and clients. There
were many nights when I accepted
editing projects without asking the
necessary questions, and ended up
seriously regretting my decision.

Bottom Line: Do Not Be Afraid
So, please do not be afraid to ask
your project manager questions.
Remember, Kurt Vonnegut loved the
translators of his books who had loads
of questions for him, since that is how
he knew his books would be translated properly. By asking questions
both before and after you have
accepted an editing job, you are
increasing the chances that the project
will end in complete success. Good
luck with your next editing project!
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Indonesian/Malay <> English
Chinese <> English

ATA

Medical
Division

20+ years of professional experience















































































































































































































ATA
2006

First
Mid-Year
Conference
May 31June 3, 2007



Rahmat Rahmat, Ph.D.
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843 Iris Ave, Sunnyvale, CA 94086
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TRANSLATION

COMPANY

FOR SALE
The Allen Translation Service,
founded in 1967 and located in the
market-rich northeastern area of the
United States, is for sale. The company enjoys a clientele that includes
a number of Fortune 100 companies,
primarily in the pharmaceutical and
chemical process industries.
Offering price: $500,000

Address inquiries to:
Allen Translation Service
P.O. Box 1529
Morristown, NJ 07962-1529
U.S.A.
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GLOBAL
MULTILINGUAL
TRANSLATIONS

ITALIAN
TRANSLATIONS
MADE IN ITALY
BY ITALIANS
FOR ITALIANS
TECHNICAL &
NON TECHNICAL

quality
speed
accuracy

Via Cavour, 15
50129 Firenze (FI)
ITALY
Tel. +39 055 2658133
Fax +39 055 2654102
http://www.gmt-ils.it
giovannim@gmt-ils.it
info@gmt-ils.it
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ATA thanks the following sponsors and exhibitors for their participation at this year’s
conference in New Orleans. See you next year in San Francisco!
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Conference
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Silver Sponsors
$2,700 Contribution

CLS Communication, Inc.
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Idem Translations, Inc.
www.idemtranslations.com
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Picking
Berries With TRADOS
By Tuomas Kostiainen

Using TRADOS is like

picking berries in a Finnish forest. If
you know the forest and where to find
the best berry patches, you will do fine
and get a lot of berries in no time
without getting lost. However, if you do
not know your way around or even what
to look for, you will end up without
berries, frustrated, lost, or perhaps even
worse, harassed by a bear. Rather than
risk this plight, many choose to stay
close to the forest’s edge, making do
with the berries they find there.
While teaching TRADOS workshops and providing one-on-one
training, I have noticed that many
translators tend to stay within the
periphery of the first useful functions
they encounter, unsure of how to venture into what they perceive as a forest
of options to get to the more advanced
features TRADOS has to offer (the
very best berry patches). “Oh, I don’t
know where to go,” or “I can’t read
the map,” they say. I realize that as a
trainer, my job is not to teach everything that TRADOS does, but to tell
workshop participants about the best
berry patches and draw a useful map
so that everyone can get there and
back, directly and safely. So, here is
my collection of some of the best features TRADOS has to offer, along
with a map for finding them.

Memory or Memories?
Many (if not most) translators use
several different translation memories
(TMs), creating a separate memory for
each client or subject. While there
might be some good reasons for this
approach in certain situations, I find it

much more efficient to use one large
memory with attribute fields (such as
“client” and “subject”). This allows
you to utilize all of the previous translations you have done for other clients,

the “Attribute and Text Field
Differences Penalty” option in
TRADOS (Options > Translation
Memory Options > Penalties) gives
priority to TUs that have the same

Having a large number of client- or subject-specific
memories defeats, to some extent, one of the main
purposes of using a TM tool like TRADOS.
or those covering a particular subject.
Having a large number of client- or
subject-specific memories defeats, to
some extent, one of the main purposes
of using a TM tool like TRADOS.
Some programs, such as Déjà Vu,
allow you to use several memories at
the same time, but TRADOS does not
(except for concordance searches,
which I will explain later). Combining
everything into one large memory
does not have to be as messy as it
sounds, just as long as you classify
your translation units (TUs) according
to client, subject matter, project
number, and/or any other attribute or
text field you might find useful.

Using Attribute Fields
Attribute and text fields (together
called TM fields) can be used as selection criteria when searching a TM
during a translation or when performing memory maintenance. How,
you ask? Just bear with me while I take
you a little deeper into the forest—it
should all make sense in a minute.
For example, during translation,

attribute/text field values as your current project by “penalizing” (= lowering) the fuzzy match levels of all
other TUs by two percentage points
per field (this is the default value, so
you do not need to do anything to set
this up).
For utilizing attribute/text fields in
concordance searches, you can select
the “Apply Current Filter Settings”
option (Options > Translation
Memory Options > Concordance) if
you want to give a priority to TUs that
have specific attribute/text field
values. And as I mentioned earlier,
these fields can also be used while
performing memory maintenance as
filter criteria when you want to utilize
find and replace operations or export a
certain subsegment of your TM, for
example (File > Maintenance >
Filter…).
Here is an example of how to set
up attribute fields and their values
(see Figure 1):
1. In TRADOS Workbench, select
“File > Setup… > Fields.”

➡
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Picking Berries With TRADOS Continued

Figure 1: Fields tab open for adding text fields and attribute fields and their values.

Selecting the Appropriate Fields
The only downside to using
attribute/text fields is that you have to
remember to select the appropriate
fields and their values before each
new project. The selection is done as
follows (see Figure 2):
1. In TRADOS Workbench, select
“Settings > Project and Filter
Settings.”
2. Select appropriate attribute/text
fields and their values for project
settings and filter settings. Note the
difference between the two:
• Project settings define the fields
and their values that will be
added into each new TU.
• Filter settings define the fields
and their values that will be used
as filters when searching the TM
during translation.

2. Select any field in the “Attribute
Fields” list.
3. Click “Add” and type a new name
(such as “Subject”) into the “Field”
input box. You now have a field
called “Subject.”
4. Select “Subject” in the “Attribute
Fields” list and then “A Value”
from the “Attribute Values” list.
5. Click “Add” and type a new name
(such as “Medical”) into the
“Field” input box. You now have
an attribute field called “Subject”
containing one value called
“Medical.” Repeat this for additional fields and their values.
6. When you have added all fields and
their values, click “OK” (do not
click “Add” at this point anymore).

24

Using Text Fields
Text fields function differently, in
the sense that you set only the text
fields but not their values in advance,
and then write the needed value in the
“Project and Filter Settings” dialog
box (see Figure 2). An example of a
text field could be a project number or
another piece of information that is
used only once. A project number is
used only for that project, but a subject name (= attribute field) will be
used every time you translate for that
subject.
If you have not yet used attribute
and text fields, it is worth spending a
few minutes to figure out what type of
field structure would be most useful in
your case. Two or three attribute fields
could be enough, such as subject and
client. Of course, you can add new
fields and their values later.

3. You can get the “Project and Filter
Settings” dialog box to appear
automatically every time you open
TRADOS or a new memory by
selecting “Options > Translation
Memory Options > General >
Show Project Settings” (you need
to do this only once).
4. Remember to change your project
and filter settings if you start working
on another translation project without
closing the TM or TRADOS.
5. Also, remember to verify your current project and filter settings before
doing an analysis or clean up.
Sounds like a hassle? Yes, a little,
but it pays off quickly. It is like using
mosquito repellent in the woods—a
hassle, yes, but you will be happy
you did.
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Figure 2. Selecting project and filter settings for a
translation project before starting a translation. Selected
fields and their values are listed in the “Current settings”
box.

Segmentation Rules
TRADOS uses so-called segmentation rules to segment the source text.
By default, segmentation rules are
based on punctuation marks so that a
segment is normally equivalent to one
sentence. This works fine in most situations, and one rarely needs to
bother with these rules. However,
there are situations where adjusting
them slightly can make your work
much more efficient.
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Using Stop Characters: I have translated numerous ingredient lists for various products (pet food, nutritional
supplements, etc.) where each list
often includes pretty much the same
ingredients, but in a different order. If
you translate these lists using default
segmentation rules, each list is treated
as one translation unit, and you end up
translating each ingredient again and
again without benefitting from your
previous translation. However, if you
include a comma or semicolon
(depending on which one is used to
separate the ingredients on the list) as
a “stop character,” you can translate
these lists ingredient by ingredient. As
a result, by the time you start working
on the second ingredient list, you will
get many 100% matches. You will also
not have to figure out how to translate
“partially hydrolyzed organic Baltic
herring liver oil” or retype it again (see
Figure 3).
Changing Segmentation Settings: To
change the settings, go to “File >
Setup… > Segmentation Rules.” You
can either create a new category for
your stop character (such as a comma
or semicolon) or just add it under
“Marks” together with the question
mark and exclamation point that are
already there. The “Segmentation
Rules” dialog box might look a bit confusing, but do not be too afraid to play
with it. With the Reset “panic button”
you can easily reset the default settings,
and no harm has been done.
Overriding Segmentation Settings:
One easy but often overlooked feature
you can use during translation to override the segmentation rules is the
“Expand Segment” (Ctrl+Alt+Page
down)
or
“Shrink
Segment”
(Ctrl+Alt+Page Up) command. This is
very handy when you want to translate
two source sentences as one target

sentence or when TRADOS does not
recognize a period at the end of a sentence as a segmentation mark (because
there is a number or unknown abbreviation right before the period). In such
situations, the segment that is opened
for translation consists of two sentences. You can expand or shrink a
segment by repeatedly selecting the
respective command as many times as
you need to, and the segment
expands/shrinks each time to the
next/previous segmentation mark.

In Love With the New TRADOS
MultiTerm
If you got frustrated with
MultiTerm Version 5 and have not
tried it since, you should take a look at
the newer version of iX or 7. The new
versions are much easier to use, and
they have made it very simple to add
new terms to a MultiTerm glossary
directly from Word or TagEditor
while translating. I use this often to
add long product names to a glossary—not so much to build a longterm glossary, but to make it easy to
copy these long names into my translation with a simple “Alt+Arrow”
keyboard command without having to
retype the entire name.
Another handy idea is to maintain a
termbase of common long words and
expressions, such as “turn right,” “counterclockwise,” and “immediately.” This
could be used for the same purpose as
MS Word’s AutoCorrect function (see
the article by Clifford Landers in the
June 2006 issue of The ATA Chronicle,
pages 26-28), but the nice thing about
this is that you do not have to memorize
anything, because MultiTerm remembers the terms for you.
Converting your old MultiTerm 5,
Word, or Excel glossaries to
MultiTerm 7 termbases is still a much
more complicated process than it
should be. However, it is not dif- ➡
25

Picking Berries With TRADOS Continued

Figure 3. Segmentation Rules tab open for adjusting segmentation rules. Here, a comma has been added as a “stop
character” in the “Marks” category to allow translation from comma to comma.

ficult if you know what to do. In case
you do not, you can download my
Quick Guide to MultiTerm iX/7 from
www.finntranslations.com/trados
help.html. It includes simple, straightforward instructions on how to convert and exchange glossaries and how
to add terms directly from Word and
TagEditor to a MultiTerm termbase
(i.e., the basics you need to know in
order to use MultiTerm efficiently
with TRADOS).

Substitutions
In addition to the default substitution of numbers, dates, and measurements, TRADOS also offers two
non-default substitution possibilities
(see Figure 4).

Figure 4. Substitutions tab open for selecting automatic substitutions. Variable names in the “Variable list” will be
treated as placeables during translation.

Acronyms Substitution: The “Acronyms Substitution” setting (File >
Setup… > Substitutions > Acronyms)
becomes handy when you are
working, for example, on software or
hardware interface instructions where
software commands or names of buttons and switches are written all in
capital letters and do not need to be
translated. When “Acronyms” is
selected on the “Substitutions” tab,
TRADOS treats all words written in
caps as placeables, and substitutes
them automatically. For example,
“Select SEGMENTATION RULES
Tab” would be a 100% match after
“Select ACCESS RIGHTS Tab” has
been translated.
Variables Substitution: The other
substitution option that everyone
should be using is called “Variables”
(File > Setup… > Substitutions >
Variables). With this you can define
words that do not need to be translated,
such as proper names, by adding them
to the “Variable List” box. All of these
words will then be treated as placeables during translation, and it is very

26

The ATA Chronicle

■

January 2007

easy to add them to the text using the
“Add Placeable” commands without
ever again having to retype them.

Useful Links

Not Fuzzy Enough
You just translated a similar sentence or phrase, but cannot figure out
why it will not come up as a fuzzy
match. Try lowering your “Minimum
Match Value %” setting from the
default 70% down to 50% or 40%.
These lower level fuzzy matches often
include useful phrases and terms. You
will also get some useless matches, but
they do not cost you anything—you
can just ignore them. To change the
setting, select “Options > Translation
Memory Options > General.”

Using Reference TM for
Concordance Searches
As I mentioned earlier, TRADOS
allows you to have only one TM open
at a time for translation, but you can
use a second memory for concordance
searches. Reference (read-only)
memory for concordance is a handy
way to utilize a second TM. You can
set TRADOS so that every concordance search is also done in the reference translation memory in addition to
the active translation memory. If you
select “Search First in Reference
Translation Memory,” the search is
done first in the reference TM and then
in the active TM (if there were no hits
in the reference TM). Otherwise, the
search is done first in the active TM. To
select the reference TM and change the
setting, select “Options > Translation
Memory Options > Concordance.”

Microsoft Glossaries
If you have been reading Jost
Zetzsche’s excellent Tool Kit newsletter
(www.internationalwriters.com), you
know about the new arrangement with
Microsoft glossaries. The applicationspecific “glossaries,” which were more
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www.apsic.com
ApSIC Xbench: for searching and viewing bilingual files, such as MS glossaries.
ApSIC Comparator: for comparing edited and unedited files, such as TagEditor files.

www.finntranslations.com/tradoshelp.html
Quick Guide to MultiTerm iX/7, along with other workshop and presentation handouts.

www.globalready.com
MSGloss2TWB for converting MS glossaries to TRADOS TM.

www.internationalwriters.com
Jost Zetzsche’s Tool Kit newsletter.

www.microsoft.com/globaldev/tools/MILSGlossary.mspx
The new Microsoft terminology translations link.

http://sdl.custhelp.com
The SDL/TRADOS support page.

like translation memories, have been
replaced by a real glossary of 9,000
English terms, plus their translations in
up to 45 different languages. The previous glossary files are now available
only to paying subscribers, so do not
lose your old files if you still have
them.
I have often been asked how to use
Microsoft glossaries with TRADOS and
MultiTerm. Here are some suggestions.
First, convert those old glossary
files into a TRADOS TM. One simple
way to do it is through a free utility
called MSGloss2TWB (www.globalready. com). Depending on the language, this memory can have
hundreds of thousands of TUs and can
be very useful if you translate any soft-

ware-related texts. This is one of the few
memories I keep separate from my main
TM, and I use it often as a reference
memory for concordance searches.
Unfortunately, the MSGloss2TWB
program does not have an option to
include attribute fields in the resulting
memory, but you can add them quite
easily in TRADOS using the “Find
and Replace” function.
1. First, you need to set up the fields
and their values if they do not
already exist in the memory, as
described earlier (see Figure 1).
2. Go to “File > Maintenance…>
Find and Replace > More,” select
the attribute field(s) and the ➡
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value(s) you want to add from the
picklist(s).
3. Select “Merge” and click “OK.”
4. Select “Begin Search” to view the
first few TUs that will be changed.
5. Select “Change”
Translation Units.”

and

“All

If you want to test your find and
replace operation, select the
“Translation Units in Current List”
option instead. That way the change
will only be applied to those TUs in
the list, and you can verify the effect
of the operation before applying it to
the entire memory. You can also do
this with a set of proper find and
replace commands in a good text
editor (such as UltraEdit), or even in
Word (Notepad is too slow for this)
before importing the .txt files to a TM.
Another handy and equally cheap
way to utilize these files is another
free utility called ApSIC Xbench

Attention
Exhibitors

(www.apsic.com). It does not allow
you to import the files into a
TRADOS TM, but it provides a powerful and convenient way to search
and view bilingual information, such
as the old Microsoft glossary files,
outside of TRADOS.
The old Microsoft glossary files
are not suitable for use in MultiTerm
because they mostly consist of whole
sentences or paragraphs of text.
MultiTerm needs a proper glossary of
terms or short phrases. Years ago, the
Microsoft glossary package used to
include a “Glossary of Standard
Terms” of over a thousand general
terms, which made it a very useful
source for a MultiTerm glossary.
However, this file has not been a part
of the package for many years. Maybe
you still have it from some old download. The file name is xx_stand.csv
(“xx” indicates a language code).
Anyhow, the new free 9,000-term
glossary file also suits this purpose
very well, but you might first want to
delete all the languages you do not

ATA’s 48th Annual Conference

•

San Francisco, California

need to make the conversion faster.
The conversion is done with
MultiTerm Convert and by selecting
Excel as the source file type. You can
find detailed instructions in my Quick
Guide to MultiTerm iX/7.

In and Out of the Woods
I hope these few suggestions and
examples have given you the courage
and knowledge to venture deeper into
the TRADOS environment and start
picking even juicier and bigger
berries. If, in spite of it all, you end up
getting lost, remember that every
TRADOS dialog box has a “Help”
button that opens online help for that
particular dialog box. Just stay calm
and read the instructions. The bears?
Yes, they are out there, but do not
worry. Just play dead, or are you supposed to run away, or is it act big and
aggressive…? Hmm, I need to check
on that.

•

October 31-November 3, 2007

Plan now to exhibit at ATA’s 48th Annual Conference in San Francisco,
California, October 31-November 3, 2007. Exhibiting at ATA’s Annual
Conference offers the best opportunity to market your products and services
face-to-face to more than 1,500 translators and interpreters in one
location. Translators and interpreters are consumers of computer
hardware and software, technical publications and reference
books, office products, and much more.
For additional information, please contact Matt Hicks,
McNeill Group Inc.; mhicks@mcneill-group.com;
(215) 321-9662, ext. 19; Fax: (215) 321-9636.
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The Association
of Translation
Companies
30th
Anniversary
Conference
By Rina Ne’eman

ATC General Secretary Geoffrey Bowden and ATC Chair Liz Robertson with Renato Beninatto of Common Sense Advisory and Rina Ne’eman, managing director of
Rina Ne’eman Hebrew Language Services.

Many of us attend ATA
conferences and events, but it is
always an interesting and welcome
opportunity when we get the chance to

African Studies. The theme of the conference was “Building Strong Markets
for Translations—Making Links and
Seizing Opportunities.” It was

Participants were treated to a full day of conference
sessions that proved thoroughly diverse and
well-presented.
explore and experience our industry
from a different perspective. One such
opportunity presented itself last year
in the form of an invitation to attend
the United Kingdom’s Association of
Translation Companies (ATC) 30th
Anniversary conference. This one-day
conference was held on Thursday,
September 21, 2006 at the University
of London’s School of Oriental and
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attended by a large and diverse group
of delegates from 24 countries, and I
had the pleasure of representing ATA.
The weather (85 degrees and sunny
in London, and at the end of
September, too!) created an atmosphere that was ideal for engaging in
lively discussions and networking
with colleagues. To help everyone get
acquainted, attendees were invited to

a cocktail party the night before the
conference sponsored by the United
Kingdom’s Institute of Translation
and Interpreting.
The next morning, after a few
words of welcome and a general introduction to the work of the association
by ATC Chair Liz Robertson, participants were treated to a full day of conference sessions that proved
thoroughly diverse and well-presented. The following is a brief rundown of the types of talks that were
given. By no means comprehensive in
scope, it is hoped that this brief list
will lead you to explore other educational opportunities in addition to
those offered by ATA.

Session Highlights
• Renato Beninatto, founder of
Common Sense Advisory, presented a global review of the international translation marketplace,
expounding upon areas such ➡
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Representatives of national translators’ associations gather at the cocktail gala on the eve of ATC’s conference. From left to right: Rina Ne’eman, representing ATA; Penny Marinou, president of the
Hellenic Association of Translation Companies; Catherine Granell, president of France’s CNET; Liz Robertson, chair of the Association of Translation Companies; Lubos Skupnik, vice-president of the
Czech Association of Translation Companies; Monika Popiolek, president of the Polish Association of Translation Agencies; Mirko Silvestrini, president of Italy’s Federazione dei Centri di Traduzione e
Interpretariato; and Joanna Waller, vice chair of the Institute of Translation and Interpreting.

as market data, leading sectors in
the purchase of language services,
top-20 translation companies, and
the “heating-up” of the midmarket. Of special interest were his
comments on branding and
insights into “what clients really
want.”
• Sarah Schuh, general manager of
Aquent, spoke about developing a
translation business into an international player.
• Jack Waley-Cohen, operations
director of Lingo24, provided a fascinating presentation on taking
advantage of the Internet to develop
a virtual translation company. With
40 full-time employees in the U.K.,
Germany, France, New Zealand,
China, and Romania, the company
has taken advantage of cutting-edge
technology to eliminate the need for
any physical office.
• Penny Marinou, president of the
Hellenic Association of Translation
Companies and the chief executive
officer of Litterae in Athens, related
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her company’s experience as a
provider of translation services for
the Olympics, explaining to U.K.
translation companies what they
could learn from Athens for the
2012 Olympic games in London.
• Claire Ingram of Wordbank spoke
about developing the role of the
translation project manager.
• Chus Fernandez Prieto and
Francisca Sempere Linares, of the
Salford University Translation
Program, followed up on Claire’s
talk with a related session entitled
“Developing Tomorrow’s Project
Managers: Academic Learning
Meets Work-base Practice.”
A selection of workshops by Liz
Robertson and Adriane Rinsche
(Language Technology Centre),
Julian Macan (IC Doc), Patrick Eve
(TranslateMedia), Don Shin (1-Stop
Translation), and Keith Laska (SDL)
rounded out the sessions. A particularly refreshing presentation was
made by Carolyn Burgess of EITI
Limited, who spoke, together with

one of her company’s clients, about
the secret of developing successful
client-translation provider relationships.

A Great Opportunity
In addition to offering excellent
speakers, I thought ATC’s conference
was extremely well organized from
beginning to end. The one-day format
was a definite change from the threeday conferences I am used to
attending, but the quality of the offerings was in no way diminished. While
there were some familiar faces, ATC’s
conference was a wonderful opportunity to get to know new players in the
translation market and to gain a more
Eurocentric understanding of the
international forces at play in the
industry.
To download a comprehensive
offering of speaker notes from the
sessions, go to www.atc.org.uk/annual
_conference2006.html.
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Interpreter
Certification
Programs
in the U.S.
Where Are
We Headed?

Certification is one of the
most important topics in the U.S.
translation and interpreting industry
today. Rarely does one attend a professional conference without finding
presentations on the topic. Numerous
articles have also been written on the
subject, and, in 2003, ATA published
an International Certification Study,
compiled by ATA President-Elect Jiri
Stejskal, consisting of 24 individual
articles from The ATA Chronicle
devoted to certification programs
around the world. These efforts have

1) To describe the history and status
of several major certification
development efforts for court and
community interpreters in order to
provide a broader understanding of
the meaning of certification and
what has been accomplished so far
in the field.
2) To offer recommendations based
on the lessons learned from interpreter certification development in
other areas.

By Nataly Kelly

An important next step for those of us interested
in the future of certification is to analyze
the information available regarding past and
current certification efforts so that we can attempt to
identify possible future paths.
been key in helping interpreting professionals, and the public at large, to
obtain information regarding current
certification programs.
To date, the objective of much of
the information made available on
certification-related topics has been to
inform end users and practitioners
about certification program details, as
well as to identify similarities and differences among programs. This body
of work has laid the essential foundation for much needed analysis.
An important next step for those of
us interested in the future of certification is to analyze the information
available regarding past and current
certification efforts so that we can
attempt to identify possible future
paths. The purpose of this article is
twofold:
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The discussion that follows is organized into several sections. First, the term
certification is defined from the perspectives of different stakeholders. Government and professional organization
initiatives for certification are reviewed,
and a brief overview of training issues is
provided to highlight these topics as they
pertain to certification. This is followed
by an analysis of certification efforts
for sign language interpreters to illustrate how certification efforts unfolded
in this particular area of interpreting.
To provide more insight on the status
of efforts in the medical interpreting
profession, a description is provided
of the foundation currently being laid
for healthcare interpreter certification.
Finally, several recommendations are
provided to stimulate further discussion.
➡
31

Interpreter Certification Programs in the U.S. Continued

Definitions of Certification in the U.S.
In the U.S., the definition of certification varies widely. An interpreter
will usually state that a certification
program involves some combination
of testing and training in a given
industry, such as court or healthcare,
and that it is granted by a recognized

mean that the individuals are certified to
work in the profession, but proves that
they have passed the requirements of
the institution’s program. For this
reason, most academic institutions refer
to their programs as certificate programs.4 However, some colleges (e.g.,
Reedley College) are beginning to use

While the test forms used for certification are consistent
across states, there are many differences in program
components and structure from one state to another.
certifying body, usually a government
entity or professional association.1
For members of certifying bodies,
the definition usually describes their
specific program, as well as the components or requirements it shares with
similar programs. Michael S. Hamm,
former executive director of the
National Organization for Competency
Assurance, an association and national
standard setting body for certification
organizations, defined the term certifying body in the following way:
“Programs that evaluate the knowledge,
skills, and abilities of individuals are
typically referred to as certification
bodies in the credentialing world.”2
According to this definition, any program that assesses the knowledge,
skills, and abilities of individuals would
be referred to as a certifying body.
Indeed, organizations, institutions, and
private companies (e.g., NetworkOmni)
have responded by developing their
own certification programs.3
Many colleges and universities that
offer interpreter training issue a certificate to students who complete a specified number of courses. The possession
of such a certificate does not necessarily
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the term certification instead of certificate to refer to their programs.5
Finally, consumers of interpreting
services will usually indicate that certification is tangible proof that a
person can provide quality interpreting services. In spite of the variety
of certification definitions in the U.S.,
they all fall under this generic definition, since they imply that an individual who successfully completes a
certification program is able to interpret with a minimum acceptable level
of quality. The way in which the minimum levels are defined and measured
varies from one program to the next.

Government and Professional
Organization Initiatives
When the Federal Court Interpreters Act was passed in 1978, the
law required Spanish federal court
interpreters to pass a certification
exam in order to demonstrate proficiency.6 This was the first such government initiative.7
Over the next two decades, several
state court systems began to follow
suit and develop their own programs
for state courts. In July 1995, the

National Center for State Courts
(NCSC) created the National
Consortium for State Court Interpreter Certification, a multi-state partnership dedicated to developing court
interpreter proficiency tests.8 This
alliance allowed state courts to combine their resources to develop creative strategies for resolving their
common concerns related to interpreter certification.9 Currently, 33
states belong to the Consortium.10
While the test forms used for certification are consistent across states,
there are many differences in program
components and structure from one
state to another.
The National Association of
Judiciary Interpreters and Translators
also created a certification program
for judiciary interpreters and translators, at the request of their membership, with the goal of elevating
professional standards. This program
is unique in that it certifies individuals
to provide both interpreting and translation services in a wide variety of
legal settings.11
Variability of programs across
states is not exclusive to legal certification programs. Some state governments, such as California and
Washington, created certifications
that are related to specific areas of
healthcare interpreting, but do not
necessarily cover the broad scope of
knowledge and skills that make up the
entire field. For example, the State of
Washington’s program is run by the
Department of Social and Health
Services, and serves as a basic
screening for mental health and social
services interpreters.12
The State of California has a state
certification exam for court administrative hearing and medical interpreters. According to the candidate
information on the CPS Human
Resource
Services
website:
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“Administrative hearing interpreters
are deemed qualified as medical interpreters.”13 The site also states that the
certification testing process for
administrative hearing interpreters
“requires demonstration of the ability
to meet minimum performance standards in consecutive and simultaneous
interpretation, plus the ability to perform sight translations of written
material and knowledge of correct
usage of legal terminology [my
emphasis],” but the program information also states that the process
includes testing in medical terminology. Essentially, interpreters with
this certification are certified to provide interpreting services during state
agency hearings that take place with
administrative law judges and during
medical exams conducted for civil
cases in order to determine monetary
awards or compensation.
The Washington and California
programs do not encompass a full
range of healthcare interpreting skills
and terminology, and are not based on
the National Standards of Practice
issued by the National Council on
Interpreting in Health Care.

Training Issues
Some certification programs effectively identify high quality interpreters
through testing; however, certification
programs have historically done little
to prepare interpreters for their exams.
Many interpreters take these tests, but
when the tests are rigorous, it is difficult for candidates to achieve passing
scores without substantial preparation,
training, and experience.
Most certification programs take
an either/or approach, meaning that an
interpreter either passes or fails, with
no clear path for an interpreter who
might not receive a passing score, but
who shows potential for someday
becoming qualified. If the interpreter
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fails, he or she must seek out training
and other possibilities for gaining
experience in order to produce a
passing result with the next attempt.
The cost of taking the test often represents a sizeable fee, so many candidates become frustrated and stop after
the first try, even if they do have
potential for someday becoming a
highly skilled professional interpreter.
The lack of attractive compensation for interpreters also presents a
dilemma. If interpreters are not hired
unless they are certified, and they
cannot pass a certification test without
training and on-the-job experience,
how will they obtain training, get
experience, pass the test, and become
certified? When programs do not provide clear steps for individuals who
show promise, but who do not yet
have the required skills and knowledge to perform at the level necessary
to pass a certification test, these individuals often become frustrated and
lose interest in the profession.
Largely in response to the low
passing rates for certification exams,
certifying bodies have begun to
acknowledge the need for training
interpreters as part of a complete certification program. For this reason,
some members of the Consortium for
State Court Interpreter Certification
began to provide mandatory minimum
training.14 Some court programs offer
orientation training prior to testing,
but these sessions are usually short in
duration and provide information on
test specifications and logistics, while
offering a basic introduction to interpreting skills and knowledge of
industry-specific terminology along
with a minimal amount of practice.15
Educational institutions and private companies offer programs
around the country to prepare interpreters for a range of interpreting settings.16 Programs vary widely, from a

40-hour certificate program at a community college to a graduate degree
program (for an example, see the
Monterey Institute of International
Studies, Graduate School of
Interpretation and Translation).17
Because these programs have different foci and areas of specialization
in preparing individuals to work as
interpreters, completion of an academic program does not guarantee
that a student will become certified.
Another challenge is that with low
rates of compensation for community
interpreters, especially in the area of
healthcare, there is little motivation
for an individual to make the major
investment required to obtain a university degree in interpreting.
It is ultimately the individual’s
responsibility to seek out opportunities for education in a given field of
study. However, the profession of
interpreting differs from others in that
most interpreters are expected to
come to the job fully prepared, often
without the benefit of any orientation,
on-the-job training, or actual interpreting experience.
There is a lack of consistency in
interpreter training programs, which
results in interpreters entering the
field with diverse backgrounds and
levels of experience. On one extreme,
there are successful interpreters who
come to their first day on the job with
a graduate degree in the field. At the
other extreme, there are individuals
who start out in the field with no
formal experience or training whatsoever and a minimal level of education.
Both have the possibility of becoming
highly skilled interpreters through a
combination of practical experience
and training.
It is still common in many areas of
community interpreting to find
working interpreters who have
received little or no training. ➡
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While it would be impractical for
these interpreters to leave their jobs to
pursue a full-time academic program
in interpreting, they do sometimes
seek training for the purposes of
learning how to do their job more
effectively.
Some private, for-profit companies
have begun to develop training pro-

interpreting profession.
In terms of converting a skilled
bilingual into a professional interpreter, there is only so much even the
best trainer can accomplish in a
matter of days. At best, these efforts
provide interpreters with a general
orientation in order for individuals to
obtain initial practice in interpreting

Some certification programs effectively identify high
quality interpreters through testing; however,
certification programs have historically done little to
prepare interpreters for their exams.
grams specifically for these interpreters, usually offering training
programs at a lower cost than academic institutions. These programs are
accessible to a wider audience and
usually offer a more practice-oriented,
hands-on approach. Since these programs often focus on providing the
essential knowledge and training that
are needed, less time is devoted to
theory and history, with more focus on
hands-on techniques and role-play
scenarios that will enable the interpreter to begin practicing immediately.
In addition, many of the state and
federal government programs, particularly the programs for court interpreting, are enhancing and improving
their inclusiveness by providing
training opportunities or, at a minimum, a list of resources where interpreters can obtain more training. Also,
many participants in programs administered by state courts actually participate in a two-day training session led
by professional interpreter trainers
that serves as an orientation to both
the certification process and the court
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skills and to gain an understanding of
the profession prior to taking a certification exam.

A View from Our Sister Profession
A national effort toward general
certification of spoken language interpreters in the U.S. is still in its
infancy, while programs of this nature
for U.S. sign language interpreters are
nearing adulthood. Taking a look at
the road toward certification in sign
language interpreting may provide
insight into our current situation.
The Registry of Interpreters for the
Deaf (RID) was born out of a group of
providers of interpreting services,
though sign language interpreters did
not have the benefit of government
sponsorship or regulation in their
early days either. Within the eight
years that followed the establishment
of RID, the organization formed a
board, developed a code of ethics, and
published a guide to interpreting for
the deaf.
During the 1970s, 18 “certifications” were in some stage of develop-

ment. A Comprehensive Skills Certificate and a Master Comprehensive
Skills Certificate, both generalist certifications, were offered, but were later
discontinued, along with several other
certificates. Between 1999 and 2003,
RID joined with the National
Association of the Deaf to create a task
force that later became the National
Council on Interpreting.
In 1999, two general tests were
created: the Oral Transliteration
Certificate (OTC) and Certified Deaf
Interpreter (CDI). Currently, RID’s
website lists 20 separate certificates.
Of these, 13 were phased out or combined with or replaced by other certificates, leaving seven available: the
OTC and CDI, the Certificate of
Interpretation (CI), the Certificate of
Transliteration (CT), the combined
certificate (CI and CT), the
Conditional
Legal
Interpreting
Permit-Relay, and the Specialist
Certificate: Legal.18 The seven
remaining certificates encompass the
necessary interpretation modes and
types that respond more effectively to
their community’s needs.

Lessons Learned from American
Sign Language Interpreter
Certification Efforts
As we analyze the experience of
our sister profession for answers and
ideas about our own development,
two major themes emerge. First, the
majority of certificates (five of seven)
that survived are general in nature,
although two industry-specific (legal)
certificates are still available as well.
After decades of a concentrated,
organized effort from national associations, the sign language interpreting
community found generalist certificates to be of a primary and prerequisite importance. In fact, sign language
interpreters must hold a generalist
certificate before they are allowed to
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sit for a specialist exam.
A second emerging theme is that
key associations have merged efforts,
and the numerous certifications previously offered are being refined into
seven more specific ones. The
remaining certifications being offered
no longer replicate other programs.
While two specialist certificates are
offered as well, the core focus is on
certifying interpreters/transliterators
according to their specific mode or
type of delivery, not according to subject specialty or industry. This is in
sharp contrast to most certification
programs in the spoken language
interpreting world, which tend to be
developed within and geared toward a
specific industry or setting (e.g.,
court, healthcare).

Laying the Groundwork for
Certification in Medical
Interpreting: The NCIHC
When looking at the progress of
the sign language interpreting community with regard to certification, it
would seem that some areas of spoken
language interpreting, particularly
community interpreting, are beginning to follow the path of sign language interpreting. We are at the point
of having numerous certifications in
multiple areas, and through strategic
alliances between organizations, are
starting to make efforts to join forces
and pool resources. Indeed, our current trajectory is similar in many ways
to that of our sister profession
described above.
A promising development is the
establishment of the National Council
for Interpreting in Health Care
(NCIHC). Born from a grass-roots
initiative in 1994, the NCIHC was
first a working group, and later
became what is today the Council.19
One of NCIHC’s strategies was to
research and publish papers on key
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topics, such as the role of the interpreter in healthcare and initial assessment of interpreter qualifications. By
putting research as a key priority,
NCIHC demonstrated much forethought and built a foundation for
future efforts.
In July 2004, NCIHC published
the National Code of Ethics for
Interpreters in Health Care. This document provides a detailed explanation
of the background of the code of
ethics, as well as a full description of
each guiding principle. Also,
NCIHC’s team conducted a thorough
analysis of existing codes of ethics in
related professions, such as court
interpreting and sign language interpreting. In addition, in order to ensure
that this document reflects the current
thinking of the profession, the team
conducted focus groups and a national
survey to receive input from working
interpreters.20
This was an important first step for
the healthcare interpreting community. As an essential next step, NCIHC
then published the National Standards
of Practice for Interpreters in Health
Care. At the time of this writing, the
standards have been endorsed by a
myriad of healthcare organizations,
private companies, and associations.
Both the code of ethics and the standards are available for download at
www.ncihc.org.

Moving Toward Healthcare
Interpreter Certification
Another step in the right direction
is being made by the Massachusetts
Medical Interpreters Association
(MMIA). MMIA has been working on
a certification program for healthcare
interpreters since 1995, when they
published their own standards of practice. With funding from the Office on
Minority Health obtained through
NCIHC, a Spanish version of the test

was piloted in 2003 through collaboration with the California Healthcare
Interpreters Association (CHIA).
MMIA is now pursuing fundraising
efforts for the creation of a comprehensive certification program.21
Just as the sign language interpreting community started to join
forces and merge efforts, we are seeing
collaborative relationships start to
solidify within the medical interpreting
realm. In the above case, we can see
that links are forming between the
efforts of NCIHC, MMIA, and CHIA.
Whether the bonds that tie them
together will become as strong as those
in the sign language interpreting community remains to be seen. However,
any collaborative efforts such as these
should be considered a positive development, since they may eventually
result in benefits of greater magnitude
throughout the interpreting professions.
Signs of progress toward healthcare certification can be examined in
more detail through a recent
California Endowment publication
prepared by Cynthia Roat. The document provides a comprehensive status
report on efforts to certify healthcare
interpreters in the U.S.22

Looking Ahead
How do the lessons learned from
our brief overview of past and current
efforts apply to the interpreting community at large, and more importantly,
what can we take from this analysis to
ensure successful certification programs in the future? What follows is a
series of recommendations regarding
how these lessons can be implemented to help the advancement of
our profession in the future.
1) When possible, we should seek to
avoid replicating existing efforts. We
have already learned this lesson in the
court interpreting community, ➡
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with many of the state-based initiatives now switching to Consortium
membership. This joint approach provides improved consistency and cohesiveness across the states, as well as
numerous additional benefits.23 In the
medical interpreting realm, if things
continue along the current path, we
can hypothesize that the current

and introductory skills training programs independently, why not partner
across our various communities to
create a strategy to address these
common components? The basic skills
and requirements of interpreting are the
same, regardless of industry. In fact,
many of the types of interpreting
referred to in this article would appear

When programs do not provide clear steps for
individuals who show promise, but who do not yet have
the required skills and knowledge to perform at the
level necessary to pass a certification test,
these individuals often become frustrated and
lose interest in the profession.
MMIA exam, or a future derivative
thereof, could become the healthcare
equivalent of the NCSC Interpreter
Certification exam, especially if partnerships continue to be formed and
efforts are continually made to work
with other state and national associations. Hopefully, this pattern of
working together will continue in
order to provide a single, national certification exam based on appropriate
and well-researched standards that can
be used for all healthcare interpreters.
2) We should consider discussing a
generalist certification for all community and court interpreters.
Industry-specific efforts can be
extremely useful as specialist certificates; however, some type of basic
guarantee of interpreting skills and
quality is still required by all industries.
Instead of each industry conducting its
own language proficiency screenings
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to fall under the larger umbrella term of
“community interpreting.”24 Since each
industry is tackling many of the same
challenges simultaneously, it would
make sense to pool efforts and achieve
efficiency and consistency.
3) We should be inclusive, not exclusive, in structuring our programs. If
we want to keep the needs of our
society in mind, we need to shift our
focus from what it takes to be a good
interpreter to what it takes to create a
good interpreter. We need to focus on
providing the infrastructure to ensure
inclusiveness, not just in terms of basic
educational courses and training, but in
terms of on-the-job experience, orientation to specific work settings, monitoring, and ongoing performance
review. We need to pull together and
make sure that basic training opportunities are not just available, but mandatory for interpreters who want to

become certified. Also, we should keep
in mind the need for some kind of consistency across training programs for
interpreters, at least in terms of basic
guidelines or standards for training.
4) We should offer programs that
are continually updated and revised.
Our programs should address the fact
that, while an interpreter certification
program may have been valid at the
time it was created, as the scenarios
(and content) to be interpreted evolve,
the testing instruments and programs
must be revised and updated accordingly. Laws are constantly being
written and modified, and new medical procedures and medications are
added each day. Obviously, our programs will never be able to keep up
with every single new item of terminology that enters our vocabulary;
however, we do need to ensure that our
programs reflect the reality of the current work of our profession. The best
way to do this may be through additional components, such as training
and ongoing monitoring.
5) We should create programs that
include a variety of requirements.
As mentioned previously, many of the
programs available only include
testing, and if interpreters are fortunate, some basic training. They do not
normally include on-the-job experience requirements, let alone monitoring, mentoring, or performance
review, yet these may be some of the
most effective tools for measuring and
improving upon an individual’s performance. While the reason for the
absence of these components is mostly
financial in the case of public entities
and not-for-profit associations, the
benefits of such components cannot be
overlooked. Perhaps pooling resources
in the future will provide a cost-saving
strategy through economies of scale,
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Lessons Learned
1
2
3
4
5
6
7
8

When possible, we should seek to avoid replicating existing efforts.
We should consider discussing a generalist certification for all community
and court interpreters.
We should be inclusive, not exclusive, in structuring our programs.
We should offer programs that are continually updated and revised.
We should create programs that include a variety of requirements.
We should incorporate language testing expertise into our program design.
We should seek to draw from various sources of knowledge.
We should devote the time and resources necessary to create quality programs.

and therefore allow more of this type
of requirement to be implemented.
6) We should incorporate language
testing expertise into our program
design. Language proficiency testing is
common to most certification programs,
and the knowledge and experience of
the language testing world is available
for the asking. However, many programs are working without language
testing experts as team members, and
therefore, not benefitting from this
expertise. If we can ensure collaborative
relationships with key scholars and
researchers from language testing who
share an interest in interpreter certification, our entire industry will benefit.
Some programs, such as the Federal
Court Interpreter Certification Program
and the NCSC, have followed this practice for the development of their exams.
As programs grow and become more
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advanced, it is recommended that
testing experts also be involved at a program development level to ensure
validity and reliability across a variety
of assessment types, and to provide
feedback on enhancing the programs.
7) We should seek to draw from various sources of knowledge. Much can
be learned from the experiences of
individuals in all areas of interpreting,
such as conference interpreting, court
interpreting, healthcare interpreting,
and sign language interpreting. Also,
given the increasing number of academic programs for interpreters, it
would be beneficial to increase communication between the interpreter
trainers providing training through
agencies and private training companies and the interpreter educators affiliated with academic institutions. In
addition, it is important to identify

models for training, certifying, and
qualifying interpreters that exist in
other countries, so that we might be
able to identify and implement best
practices within the U.S. Finally, we
should make use of the growing
corpus of literature available on
quality in interpreting, which includes
research by many authors, such as
Franz
Pöchhacker25,
Miriam
Schlesinger26, Barbara Moser-Mercer,
Ulrich Frauenfelder, Beatriz Casado,
and Alexander Künzli27, as well as
Ingrid Kurz.28 This body of work has
grown steadily over the past decade,
and continues to evolve.
8) We should devote the time and
resources necessary to create quality
programs. This is easier said than
done, especially since most of the individuals currently involved in certification program design at a public or ➡
37

Interpreter Certification Programs in the U.S. Continued

association level are facing a lack of
funding. Also, even when funding is
granted, our struggle is often to provide
something tangible within a quick timeframe in order to obtain or renew that
funding. However, as we have seen, a
rush to move forward can often create
fragmented efforts and result in going
back to the drawing board, albeit
decades later. In the long run, multiple
individual efforts turn out to be significantly more expensive and time-consuming. Organizations such as NCIHC

certification to take these key lessons,
discuss their merit, and create something that can accomplish our goal of
ensuring access to high quality language services across the nation, so
that individuals and society as a whole
may benefit from our initiatives.
The author would like to acknowledge
Frances Butler, David B. Sawyer, and
Jean Turner for their valuable input
and guidance. Also, special thanks to
Shiva Bidar-Sielaff and Karin Ruschke

We need to pull together and make sure that basic
training opportunities are not just available, but
mandatory for interpreters who want to become certified.
and MMIA have been successful in
finding ways to secure funding through
grants and endowments. Those are definitely steps in the right direction, but
more financial support is needed to
carry these efforts forward.

of NCIHC, as well as Izabel Arocha,
Joy Connell, Maria-Paz Avery, and
Jane Kontrimas of MMIA, for providing input about these organizations
to ensure accurate representation in
this article.

Conclusion

Notes

In summary, there are a host of
issues pertaining to interpreter certification that need to be discussed,
examined, and scrutinized by all individuals interested in the role of certification in the court and community
interpreting professions. However, we
may benefit most from coming
together and joining forces. History
and experiences from similar professions would seem to tell us that by
sharing knowledge and working collaboratively, we may avoid pitfalls
experienced by others on the certification journey.
Now, it is up to those of us who care
deeply about interpretation quality and

1. A similar definition of “certification” is provided on page 4 of The
Terminology of Health Care
Interpreting, A Glossary of Terms
(National Council for Interpreting
in Health Care, October 2001).
www.ncihc.org/NCIHC_PDF/The
TerminologyofHealthCareInter
preting.pdf.
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ncsconline.org/wc/publications/
Res_CtInte_ModelGuidePub.pdf.
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22. Roat, Cynthia E. Certification of
Health Care Interpreters in the
United States. A Primer, a Status
Report and Considerations for
National
Certification
(The
California Endowment, September
2006).
23. Cantrell, Melissa, Paula Hannaford,
Catherine Gill, and William E.
Hewitt. Court Interpreting Services
in State and Federal Courts:
Reasons and Options for InterCourt Coordination (Williamsburg,
Virginia: National Center for State
Courts, Oct. 30, 1998, NCSC KF
8807.C68). www.ncsconline.org/
WC/Publications/KIS_CtInteInterp
Serv.pdf.

Benjamins, 1994). http://interpreters.
free.fr/simultaneous/schlesinger.htm.
27. Moser-Mercer, Barbara, Ulrich
Frauenfelder, Beatriz Casado, and
Alexander Künzli. “Searching to
Define Expertise in Interpreting.”
In Language Processing and
Simultaneous Interpreting. Edited
by Englund Dimitrova, Birgitta
and Kenneth Hyltenstam, (John
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diverse areas of linguistics, such as
sociolinguistics, cognitive science,
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issues available at http://mambo.
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Start

planning now!
ATA’s 48th Annual Conference
October 31-November 3, 2007

26. Schlesinger, Miriam. “Does Intonation Matter?” In Bridging the Gap.
Empirical Research in Simultaneous Interpretation. Edited by S.
Lambert and Moser-Mercer (John
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American Translators Association

47 Annual
Conference
th

New Orleans, Louisiana

· November 1-4, 2006

For more conference photos, check out:
www.atanet.org/conf/2006/conference_photo.htm

New Orleans Round Robin Tennis Results

Category A Winners (right)
Miwako Inoue
Michael Smolens

Runners-up (left)
Cindy Calder
Arturo Valdivia

Category B Winners (right)
Alex Alvarez
Victoria Spellman

Runners-up (left)
Daniel Bossut
Bruni Johnson
Thanks to everyone who participated, especially to organizer Robert
Croese, whose hard work made this
year’s Round Robin Tennis event
such a success. See you next year in
San Francisco!
Photos by Robert Croese

The following tools are offered free of charge by the Translation Bureau of the
government of Canada:

Free Online
English↔French

Tools Available

42

The Avalanche Bulletin Vocabulary
www.translationbureau.gc.ca/pwgsc_internet/fr/publications/gratuit_free/voc_av
alanche_e.htm
The Diamond Cutting Vocabulary
http://www.translationbureau.gc.ca/pwgsc_internet/fr/publications/gratuit_
free/voc_diam_e.htm
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ATA Certification Exam Information
Upcoming Exams
California
San Diego
March 10, 2007
Registration Deadline:
February 23, 2007

Oregon
Portland
May 18, 2007
Registration Deadline:
May 4, 2007

Utah
Salt Lake City
February 10, 2007
Registration Deadline:
January 26, 2007

San Francisco
April 7, 2007
Registration Deadline:
March 23, 2007

Pennsylvania
Philadelphia
March 24, 2007
Registration Deadline:
March 9, 2007

Washington
Seattle
April 28, 2007
Registration Deadline:
April 13, 2007

Texas
Irving
March 17, 2007
Registration Deadline:
March 2, 2007

Uruguay
Montevideo
March 10, 2007
Registration Deadline:
February 23, 2007

Illinois
Chicago
January 27. 2007
Registration Deadline:
January 12, 2007
Kansas
Lawrence
April 1, 2007
Registration Deadline:
March 16, 2007

All candidates applying for ATA certification must
provide proof that they meet the certification
program eligibility requirements. Please direct all
inquiries regarding general certification information to ATA Headquarters at (703) 683-6100.
Registration for all certification exams should be
made through ATA Headquarters. All sittings have
a maximum capacity and admission is based on
the order in which registrations are received.
Forms are available from the ATA website or
from Headquarters.

New Certified Members
Congratulations! The following people have successfully passed ATA’s certification exam:
English into Portuguese
Ronaldo Alves de Oliveira
São Paulo, Brazil

English into Spanish
Jesús Clemente
Madrid, Spain

French into English
Dounia Loudiyi
Bethesda, MD

Spanish into English
Jamie Feliu
Colorado Springs, CO

English into Russian
Michael A. Kislov
Moscow, Russia

Maria de la Garcia Cortes
San Francisco, CA

Italian into English
Alessandra Cortese de Posis
Arlington, VA

Nicholas S. Pizzigati
Guanajuato, Mexico

Irina M. Spinosa
Seattle, WA

Maria A. Litwin
McKinney, TX
Maria J. Lucas-Perez
Los Angeles, CA

ATA Ethics Course
All certified members are required to earn one continuing
education point by completing an ethics course.
For details, go to:
www.atanet.org/certification/online_ethics_overview.php
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Active Membership Review
Congratulations! The Active Membership Review Committee is
pleased to grant corresponding member status to:
Paulette G. Racine Walden
Vaudreuil-Dorion, Quebec, Canada

43

Certification Forum Terry Hanlen, Certification Program Manager
Terry@atanet.org

The Continuing Education Points Reporting Cycle Has Begun

It is reporting time for
the first cycle of the Certification
Program’s Continuing Education
Points. Certified members must earn
20 points every three years until the
age of 60.

• The regular deadline for this
first reporting period is January
1, 2007 for members who were
certified prior to January 1,
2004. Members certified after
that date will be notified that
they must report points three
years from their date of certification.
• Please complete the Continuing
Education Record online by
going to www.atanet.org/membersonly/cep.php. The form
may be completed and submitted online at this site. If you
prefer to fill the form out and
fax or mail it to us, you can go
to www.atanet.org/certification/
aboutcont_record_form.php.

• All members who are reporting
points must either complete the
online ethics course (www.
atanet.org/certification/online_et
hics_overview.php) or have completed a similar course approved
by ATA during this first reporting
period. Please indicate that you
have completed this requirement
on your Continuing Education
Record by listing it as a Category
A event.
• If you are 60 or over, simply fill
out the contact information and
check the box on the first page
of the Continuing Education
Record and return it to us.
• Do not submit any backup documentation to support the
points you are claiming at this
time. Members who are audited
will be asked to supply proof
that they earned the credits submitted. All members are
required to keep their backup
documentation for one year
from the date of reporting.

• A member will be decertified if
the appropriate continuing education requirements have not
been fulfilled by the deadline.
Please see the policy for decertification and reinstatement at
www.atanet.org/certification/
aboutcont_administrative_poli
cies.php.
• The reporting date for your next
20 points will be three years
from the current reporting date.
Additional points may not be
carried over from one reporting
period to another.
• If you have any questions, please
contact Jonathan Mendoza at
jon@atanet.org.

Korean
Language
Division

Established
ATA’s
Membership Directory
You’ll find the most up-to-date
contact information for your
ATA colleagues online, day or night!
Search by name, location, even by
e-mail address—
just click
www.atanet.org/
membersonly.
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Keeps
You
Connected
All
Year

ATA is proud to announce
the establishment of its
newest division, the Korean
Language Division. Please visit
www.ata-divisions.org/KLD
for more information. Also,
be sure to subscribe to the
discussion listserve by
sending an e-mail to:

ata-Korean-subscribe
@yahoogroups.com.
Note: You must be an ATA
member to belong to any of its
divisions.
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Success by Association

ATA’s newest

Tennessee Association of
Professional Interpreters
and Translators:
Tennessee’s Language Bridge

affiliate group,
The Tennessee Association of Professional Interpreters and Translators
(TAPIT), is a professional organization for interpreters and translators of
written, spoken, and signed languages
in Tennessee and surrounding
states. TAPIT’s members are professional interpreters and translators who
help facilitate communication for
Tennessee’s businesses and governmental agencies, as well as their peers
and clients worldwide. They strive to
bridge cultural and linguistic gaps,
break down language barriers, and
help ensure effective communication
between Tennesseans, with and
without English proficiency, in the
public and private sectors.

• Serve in an advisory capacity to
interpreters, translators, courts,
court administrators, attorneys, law
enforcement, healthcare providers,
and businesses regarding issues
related to the professions of interpreting and translation.

Goals

Activities

TAPIT enhances the professional
image of translators and interpreters by
educating the public and users of language services, while stressing the
importance of language proficiency
through certification in one or more languages. TAPIT strives to bring together
court, medical, community, and sign language interpreters and translators in
Tennessee and build upon their common
interests and concerns in order to create a
statewide presence that will:

• Publishes a quarterly newsletter,
the TAPIT Times.
• Organizes and conducts courses and
workshops for interpreter and translator training and continuing education. Meetings usually feature a guest
speaker who addresses a topic of
interest to translators, interpreters,
and transliterators. Meetings are free
for members and first-time visitors.
Non-members are welcome to attend
for a donation of $5, which can be
applied toward their membership
dues if they decide to join. Meetings
are posted on TAPIT’s website.
• In addition to its meetings and workshops, TAPIT also hosts an annual
conference. This year’s conference
will be held September 14-16, 2007
at Belmont University in Nashville,
Tennessee.

• Advocate on behalf of, and promote the interests of, the interpreting and translating professions
in Tennessee.
• Foster the highest level of ethical and
professional standards of interpreting and translation in Tennessee.
• Provide a forum for the discussion
of interpreting and translation
issues among interpreters and
translators, courts, legal services,
and healthcare providers, as well
as with the agencies and individuals who contract for interpreting
and translation services.
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Quick

Facts

• Acronym: TAPIT

• Mailing Address:

• Established: September 28, 2002

TAPIT

• Area Served: Tennessee and

P.O. Box 91116

surrounding states

Nashville, TN 37209

• Website: www.tapit.org
• E-mail: info@tapit.org

Website
TAPIT’s website (www.tapit.org)
contains:
• A membership directory, organized
according to location, specialty,
and certification.
• A services page where members can
place a description of the products
and/or services their company offers.
• An events calendar and minutes
from past meetings.
• A link to TAPIT’s bylaws.
• A “Frequently Asked Questions”
page with basic facts about translators and interpreters for the benefit
of beginners and nonlinguists alike.
• Powerpoint links to speaker presentations from TAPIT conferences.
• The TAPITORG listserve, a discussion group for TAPIT members to
send and receive information, ask
questions, and request assistance with
the translation of terms and words.
• Links to websites of interest to
translators and interpreters.
• Links to articles of interest to the
profession.

ATA chapters, affiliates, and local groups serve translators and interpreters in specific geographic areas. They provide industry information, networking opportunities, and support services to members at the local level and act as liaisons with the
national association. This column is designed to serve as a quick resource highlighting the valuable contributions these organizations are making to the association and the profession as a whole.
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GeekSpeak

Jost Zetzsche
jzetzsche@internationalwriters.com

Translation Memory Authoring

Whether you like it or hate

it, technology plays an important role
in our professional lives. In most
cases, our work lives and technology
have a sort of tag-team approach: the
demands of the work life determine
what needs to be improved in the
technology sector, and, in turn, these
improvements lead to higher
demands, and so on. Every once in a
while, however, the roles are reversed.
In these rare cases, technology provides a quantum leap in the way we
work and operate without us having
demanded it. Examples of this include
the FAX, the PC (and, yes, this
includes all personal computers,
including Macs!), the Internet, or
translation memory (TM) technology.
Now again, still unnoticed by most
of us, a new technology is entering
our work lives. Strictly speaking, it is
not even that new—it is a bit like the
emperor in a new suit of clothes.
However, the potential impact is
enormous. I am talking about TM
authoring, the really rather simple
process by which existing TMs are
used to create source texts.

Not exciting? Think of the implications. TM technology has become a
ubiquitous technology that has been
used for the last 10 or 15 years. The
amounts of data that have been assembled are gargantuan. For instance,
Microsoft just announced that it had
entered the one hundred-millionth
translation unit (= combination of
source and target segments) into its
TM. But despite this accumulated
mass of existing data, the match rates
we receive when using TM technology often disappoint. Why?
Because most source text authors are
just “too creative.” With this new TM
authoring technology, however, it is
possible to tailor the source text to
existing entries in translation memories, resulting in (a) more consistent
writing that (b) is not stylistically
inferior as is sometimes the complaint
in “controlled” authoring, and (c) produces match rates in the translation
phase that will be many times higher
than those we get today.
So what does this mean for us?
Incredible opportunities. Of all parties involved in the documentation/

Call for Submissions
Beacons, Volume 10
ATA’s Literary Division is proud to announce that Michele
Aynesworth will be the guest editor of the next edition of
Beacons, the division’s annual publication of literature in
translation.
Submission deadline: March 1, 2007
For additional information or questions, please contact
Michele Aynesworth at mmaynesworth@htu.edu.
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translation processes, who best
understands how to deal with TMs?
Who has already experienced the pitfalls of introducing this technology,
resulting in forced changes to
ingrained work habits? That would be
us, of course—members of the language industry. This is our chance to
tear down the artificial divide
between authoring and translation
and expand our service portfolio into
writing source documents, thanks to
this sophisticated new approach to a
technology that we have all (grudgingly) gotten used to.

The GeekSpeak column has two goals:
to inform the community about technological advances and at the same time
encourage the use and appreciation of
technology among translation professionals. Jost also publishes a free technical newsletter for translators
(www.internationalwriters.com/toolkit).

Take Advantage of Your

Membership Benefits
Collection Services/
Receivables Management
Dun & Bradstreet
Mike Horoski
(800) 333-6497 ext. 823 7226
(484) 242-7226
michael.horoski@rmsna.com
www.rmsna.com
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Business Smarts

In order to protect docu-

ments from unauthorized changes
and save on faxing and mailing costs,
many companies have switched to
e-mailing source-text documents as
PDF (Portable Document Format)
files. While this cross-platform file
format is ideal for sharing content
with others, it presents a number of
challenges to freelance translators.

Dear Business Smarts:
Recently I have received a number
of requests for quotes, mostly from
translation agencies, based on documents in PDF format. Since these
documents have to be converted to a
different format in order to determine
a word count, it can be quite timeconsuming to prepare a quote, with
no guarantee that my cost estimate
will ultimately be accepted. In one
particularly bad case, I received 12
separate PDF files, each one page
long, for a “quick quote.” Is this a
new standard practice?
I typically run PDF files through
an optical character recognition
(OCR) software package I bought,
which yields good but not perfect
results. If my quote is accepted, the
output files then have to be cleaned
up and corrected before I can translate them using a computer-assisted

Comments?
ATA members can discuss
business issues online at the
following Yahoo! group: http://
finance.groups.yahoo.com/group
/ata_business_practices.You
will need to register with Yahoo!
(at no charge) if you have not
already done so, and provide your
full name and ATA member
number in order to join the group.
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Working With PDFs

translation tool. The simple fact is
that working from a PDF source takes
longer and involves extra formatting
work. What do you advise?
Sick of PDFs

Dear Sick:
There are many uses for PDF files,
but the practice of sending a file
without a word count to a freelancer
for a “quick quote” should not be
among them.
In the translation industry, PDF
has become the preferred format for
documents that used to be transmitted by fax, such as legal briefs,
medical reports, etc. Business Smarts
is of the opinion that it is the responsibility of agencies to provide their
clients with an accurate quote and
the exact terms of a transaction,
before the assignment can be given
to a freelancer. No matter how harried a project manager may be, it is
not acceptable to transfer to you, the
translator, the task of quoting a job or
determining the word count. If the
request is an isolated incident, it is
probably best to let it go in the
interest of preserving a good
working relationship. But sending 12
separate pages that have to be
decoded individually with optical
character recognition software—or

worse, printed out for a manual word
count—is simply too much.
Your best response would be to
send a polite but firm message indicating that you are interested in the
job, but feel that you can offer a
better price (your regular rate) when
you are supplied with an accurate
word count. Otherwise, your quote
will, unfortunately, be higher because
the word count is not immediately
apparent and you do not want to risk
cutting yourself short.
Some colleagues have established
a fixed surcharge for working from
hardcopy and PDF documents to
compensate for the extra formatting
requirements and the difficulty of
using computer-assisted translation
tools. In many cases, even direct
clients will provide an editable copy
of documents, such as press releases,
procedures, technical manuals, etc., if
they are informed that translating a
PDF document takes longer and
therefore costs more. They may also
be pleased to learn that a translator
working from native word-processor
files can offer better quality and accuracy, since elements such as tables
and lists do not need to be laboriously
(and possibly inaccurately) re-typed.

The information in this column was compiled by members of ATA’s Business
Practices Education Committee for the benefit of ATA members. This column is not
intended to constitute legal, financial, or other business advice. Each individual or
company should make its own independent business decisions and consult its own
legal, financial, or other advisors as appropriate. The views expressed here are not
necessarily those of ATA or its Board of Directors. Send your questions about the
business of translation and interpretation to The ATA Chronicle—BPEC Q&A; 225
Reinekers Lane, Suite 590, Alexandria, VA 22314; Fax: (703) 683-6122;
E-mail: businesspractices@atanet.org. Questions must be accompanied by a
complete name and address, but will be published anonymously or pseudonymously
upon request.
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The Onionskin

Chris Durban
chrisdurban@noos.fr

National Association for the Self-Employed Scores with Translation Tips

Founded in 1981 by a group

of small business owners, the National
Association for the Self-Employed
aims to provide input to help even the
smallest businesses succeed. Today it
represents hundreds of thousands of
entrepreneurs and micro-businesses,
and claims to be the largest nonprofit,
nonpartisan group of its kind in the U.S.
And a source of useful information it
most definitely is, says a sharp-eyed
Onionskin reader. An article in the
May/June 2006 issue of the association’s magazine, Self-Employed, tackles
marketing to the emerging Hispanic
market with tips that include: “Prepare
your infrastructure for Hispanic customers. This encompasses every aspect
of your business...from taking great
care in translating your marketing
materials to training your employees in
both language and cultural issues.”
The article continues: “Don’t do it
on the cheap. If you want to devise an
effective Hispanic marketing strategy,
you can’t cut corners.” Music to the
translator’s ears—and advice that even
big businesses would do well to heed.

In Case of Fire, Save Your Ass?
Explaining how translation errors in
a foreign language distract readers from
the message can be laborious, especially for a public of monolinguals.
Enter a fire safety brochure for Urduspeaking communities across Scotland,
with a mistake that set the international
media on fire when flagged by the Daily
Mirror in November.
Should your building catch fire,
says the English source text, “Never
jump straight out of a window, lower
yourself on to a cushion etc.”
In Urdu, this becomes, “Never jump
out of a window straight. Put yourself
on a donkey etc. and come down.”
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As with many language glitches,
the misstep came at the all-important
proofreading stage—here, the Urdu
word for cushion (gadda) was confused with donkey (gadha). Spellcheckers can do that to you, whatever
your language, which is why language
professionals insist on a final check
before documents go to press.
Whodunnit? The Mirror fingered
the Strathclyde Fire and Rescue
service, but when we called,
spokesman Alan Forbes said it was a
case of mistaken identity. The leaflet
was in fact produced by the Scottish
Executive—the executive arm of the
Scottish Parliament.
“We got blamed because the first
person to spot the howler and report
it lived here in Strathclyde,” he told
the Onionskin.
The Scottish Executive published
the brochure in Urdu, Punjabi,
Cantonese, Bengali, Gujarati, Hindi,
and Arabic, and has apparently received
no comments on other language versions. New leaflets in selected Eastern
European languages are also in the
pipeline, reflecting the influx of immigrants from those countries and efforts
to reach out to new residents.
Generally speaking, said Strathclyde
Fire and Rescue’s Mr. Forbes, there is
a shift from words to graphics, which
bring home the message more efficiently. And there is clearly a need:
there are 63,000 house fires in the
U.K. every year, resulting in 14,000
people being injured and 500 deaths.

City Lost in Translation
In August, officials in Jerusalem
blundered in commissioning a translation from Hebrew to English to promote the city as a tourist venue for a
music and arts festival, notes another
correspondent.

The pamphlet should have read
“Jerusalem—there’s no city like it!”
but instead the English version said
“Jersualem—there’s no such city!”
reported Israeli newspaper Maaiv.
Tens of thousands of copies were distributed before city officials became
aware of the mistake. In an interview
with the BBC, city spokesman Gidi
Shermling passed the shekl with an
intriguing new twist (or was it simply
more language slippage?): “The flyer
was apparently translated by someone
outside the municipality.”
He appeared to be referring to an
outside supplier, i.e., not a municipal
employee, rather than to a resident of
another town or city.
For language professionals, the
slip-up is simply another example of
unfounded faith in a nonnative
speaker’s command of English. As
one observer of the international political scene comments, “Jerusalem’s
status has been disputed, but never to
this extent.”
With thanks to Bob Blake, Louise
Gough, Rina Ne’eman, Diana Rhudick,
Marcela Sariego, Philip Slotkin, Bob
Symonds, and Beverley Wahl.

The Onionskin is a client education
column launched by the ITI Bulletin (a
publication of the U.K.’s Institute of
Translation and Interpreting) in 1996.
Comments and leads for future
columns are very welcome; please
include full contact details. Contact:
chrisdurban@noos.fr or fax
+33 1 43 87 70 45.
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The Translation Inquirer

John Decker
jdecker@uplink.net

A recent article in the online

version of the Pittsburgh Post-Gazette
discussed U.S. immigrants with hyphenated names, and the difficulties they
have in finding anyone who can correctly pronounce or transcribe their
names. Some of these immigrants give
up and follow a long tradition by
legally changing their names to something that the average American can
read, pronounce, and transcribe with
ease. Others—and this is becoming
more common—dig their heels in,

New Queries
(Cr-E 1-07/1) CUJ would like to
know about a name for a legal
instrument in Croatian inheritance
procedures. As a noun, it is “uvo√enie
u posjed,” and its verb form is “uvesti
[nekoga] u posjed.” The exact
corresponding legal procedure and
term might not even exist in English. It
is a document that permits a process of
passing a piece of real estate from a
donor to a donee while bypassing a
court probate hearing.
(Cr-E 1-07/2) Again from CUJ, here
is a phrase that she found numerous
very stilted English equivalents for,
but all lacked that satisfying feeling.
The phrase is one that proclaims the
mission of the Croatian Philological
Society: “Hrvatski se jezik voli
snanjem.” This dictum is terse but
multilayered, hence the difficulty of
getting acceptable English for it. Here,
finally, in this column is some
Croatian you can sink your teeth into!
(E-Po 1-07/3) This came from a ProZ
translator who wondered how to deal
with “the Court will hear and dispose

saying in effect, “My name is an
essential part of my national heritage,
it is who I am, and I am not changing
it!” As the Translation Inquirer read all
this, he felt comforted. Most practitioners of our profession would either
get the name right the first time, or
would remember it after a single correction and never say or write it incorrectly again. After all, many of the
U.S.’s ATA members find themselves
in this hyphenated category!

of the case in your absence,” particularly the words in bold print. How
would that turn out in Polish?
(E-Sp 1-07/4) This query pertains to
nautical terminology, and the problem
phrase (perhaps incomplete) is: rotary
switches complete with operating lever
and mechanism for mooring winch co,
the final word perhaps being combination or complex. Even with that slight
bit of uncertainty, though, there is,
thinks the Translation Inquirer, enough
context to allow attempts to provide
good Spanish for it.
(G-E 1-07/5) A user of Lantra-L had
trouble with the words in bold print
in this quote, taken from an assessment of small cars: “Der Ibiza
absolviert sämtliche Prüfungen
schnell, sicher und ohne besonderen
fahrerischen Aufwand. Seine straffe
Federung, die unter voller Beladung
dennoch auf Block gehen kann,
wirft ihn beim Komfort aber zurück.”
Is this a reference to some kind of
emergency system, and if so, what
about the English?
(G-E 1-07/6) Mark Herman noticed at

Abbreviations
used with this column

A-Arabic
Cr-Croatian
E-English
G-German
Gr-Greek
I-Italian

Po-Polish
Pt-Portuguese
R-Russian
Sp-Spanish
Sw-Swedish

the end of Act I of Carl Maria von
Weber’s autograph score for the opera
Der Freischütz the notation “Erster Akt
vollendet Dresden d. 30 Nov. 1819. w
auf 12 Uhr nachts T.D.C.” What does
the abbreviation “T.D.C.” mean?
(I-E 1-07/7) The term “atto motorio”
appeared in a list of psychologyrelated terms, and the translator-user of
ProZ who encountered it was stumped.
What could it be? Replies had started
to come in to ProZ by the time the
Translation Inquirer encountered this,
but none of the responders felt much
confidence about their accuracy.
(Pt-E 1-07/8) A ProZ user wants to
know what “documento próprio”
means. It appears at the end of a signature-authentication document entitled “registrada na Conservatória do
Registro Comercial de Lisboa,
xxxxxxx, em documento próprio.”
(R-E 1-07/9) This began life as an
attempt to provide a German equivalent, and that should still be the goal.
An educational credentials document
discussed something a student did not
do, and then added, …xnj b ghbdtkj
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The Translation Inquirer Continued

r pfyb;tyyjq d djcgbnfntkmys[
wtkz[ jwtyrt. Someone try to deal
with this!

text or in iDafa constructions. It is rarely
used in dictionaries, and is transliterated
either with a final “a” or “ah.”

(R-E 1-07/10) A member of Lantra-L
had to translate the name of an educational institution from the old, unlamented U.S.S.R. that included jhltyf
nheljdjuj rhfcyjuj pyfvtyb, and
wonders how best to render this phrase
into English. The Translation Inquirer
has dealt with this and has his own
notion, but his solution is admittedly
roundabout and long-winded. Are
there any good suggestions for this?

(E-R 6-06/3) (online ticket): Avoiding
any Russian solutions involving
online, Vera Shakhov wants to play a
bit with less obvious solutions: <bktn>
regktyysq xthtp bynthytn& gj bynthytne& yf bynthytnt& d bynthytnrfcct. Here, in fact, is a perfectly
reasonable informational sentence:
<bktn vj;yj regbnm d rfcct> c her>
gj ntktajye> bynthytne.

(Sp-E 1-07/11) The final six words of
the following quote made things difficult for this ProZ explorer:
“Pertenecen al género Chamaedorea,
uno de los más complicados en la
familia de las palmáceas, pues se
conocen casi cien especies cual de
todas ellas más variada.” Please help
with the English if you can.
(Sp-E 1-07/12) A ProZ member
encountered a letter about changes in a
compensation structure. The writer
explained that the two prior negotiations he has had with YYY have been
unsatisfactory. The words in bold
proved to be a problem: “He tenido 2
negociaciones anteriores en YYY, La
1ª. -A final del año 2002 ...[text shortened] ...La 2ª. -Un desajuste de contabilidad por un decomisionamiento
mal hecho de EMPRESA XX y un
cobro de muestrarios de textil y
calzado de años anteriores, ilegal.”
What about those problem words?

Replies to Old Queries
(A-E 10-06/1) (ghallayet): Jeffrey
Hayes found several hits with
“Ghallaya” and a couple more on
“Ghallayah.” The final taa’ marbuTa
only becomes a “t” in a fully voweled

(E-Sp 10-06/3) (firing dryer): John
Barreiro says that in the context of the
query, a firing dryer is a device where
objects that need to have their liquid
content extracted (in this case, tea
leaves) are placed. The resulting steam
or vapor is captured and condensed to
produce a distillate that is the essence
of the original. Think of it as a still for
solids. John’s Spanish translation
would be “Alambique,” because that is
the basic function of the device.
The term firing dryer is more commonly applied to devices used to dry
lumber and other materials, as in a kiln
(thus, the term Kiln dried lumber). In
that case, the translation would be
“Secador continuo.”
(Gr-E 10-06/8) (olive extract): Ilse
Andrews found this to be badly hammered in the original Greek, but came
up with reliable English: anti-aging
action of extracts from the Greek olive
(Koroneike variety) and oleoevropini
[word not found, but obviously a
plant] by means of preserving the
function of the proteo-body in human
skin growth.
(R-E 10-06/9) (dblj-dhtvtyyst
ajhvs ukfujkf): Vadim Klishko calls
these aspectual-temporal verb forms.
Wayles Browne explains this by saying

that these are aspect-tense forms, or as
we usually say in English, tense and
aspect forms of verbs. Denes Marton
puts a little more meat on the bones by
saying that Dbl means, in grammar,
aspect (i.e., perfective or imperfective
aspect). Thus, the whole phrase refers
to the forms of verbs in different
aspects and tenses. Granted, the concept of the aspect does not exist in
English grammar, but the difference is
like doing something or getting something done (ltkfnm or cltkfnm). These
are considered to be the two aspects of
the same verb, and almost all Russian
verbs have two forms corresponding to
the two aspects.
Vera Shakov provides these
English versions of the original
phrase: “Specific combination of verb
aspects and time used to express emotional tension,” or “Specific usage of
verb aspects and time combination to
express emotional tension.”
(Sp-E 8-06/7) (E.S.D.): Two replies,
coming 28 minutes apart, arrived on
the same day about this. The first one is
from Mark Bogan, who currently lives
in Costa Rica, but used to live in
Colombia where the query originated.
He says that “E.S.D.” stands for “En su
despacho” (delivered to the office), and
that it is related to “E.S.M.” (“en sus
manos”), which is delivered in person.
Victoria Mendoza, a new ATA
member (welcome!), rendered the two
above abbreviations slightly differently as in your office and in your
hands, respectively. The latter usage
applies particularly to party invitations
and personal notes.
Hazel Sanabria, Leonor Valderrama
de Sillers, and Yvonne Daugherty
wrote worthwhile replies about this
query, but I will take the liberty of
postponing their comments until the
next issue.
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Member News

• Advanced
Communication
and Translation, Inc., established by former ATA Treasurer
Monique-Paule Tubb, celebrated its 11th anniversary in
2006.
• Eriksen Translations received
a 2006 MarCom Creative Award
from the Association of
Marketing and Communication
Professionals for its 20th
anniversary 2006 calendar. The
MarCom Creative Awards is an
international competition that
recognizes outstanding achievement by marketing and communication practitioners.
• Michael C. Kidd has been
appointed executive vice-president of marketing and sales at
ProZ.com.

Do you have news that you would like to share
with your colleagues? Send it to Jeff Sanfacon at
jeff@atanet.org. Submissions subject to editing.

• Language
Line
Services
announced the launch of Your
World. Your LanguageSM, a free
over-the-phone interpretation
service connecting limitedEnglish-speaking consumers to
vital business, city, and community services and entertainment
venues.
• Lionbridge Technologies, Inc.
is localizing the website for The
Well Project Inc. to provide
multilingual content for the support and education of women
with HIV and AIDS.

• Uwe Muegge, the author of
Translation
Contract:
A
Standards-Based Model Solution, announced the availability
of a PDF version of his book for
immediate
download
(see
www.muegge.cc). The print version is available at amazon.com.
• Cheryl Pfeiffer, director of
interpreting and translating at
Fluent Language Solutions,
received the Charlotte Business
Journal’s Women In Business
Achievement award.

• Corinne McKay published
How to Succeed as a Freelance
Translator. See amazon.com for
details.

The Translation Inquirer Continued
(Sp-E 8-06/8) (zapateo): Sharlee
Merner Bradley says that if no one has
responded to the English translation of
“zapateo” in the given context, she suggests hammering, chattering, pounding,
thumping.
(Sw-E 10-06/10) (lamier): Wayles
Browne claims to be more of an amateur in Scandinavian, but can suggest
that “lamia” is a supernatural beast: a
witch who was supposed to suck children’s blood, a sorceress. It can also
refer to a kind of flatfish, a species of
owl, a fabulous monster, or a fish of
prey. Peter Christensen had never seen
this before, but thought to look it
up. From the Internet he learned that the
word crops up in Strindberg and
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Rydberg in Swedish, and in Hans
Christian Andersen in Danish. It is a
children-eating figure from Greek
mythology with the head and breasts of
a woman and the body of a lion or dog
or serpent, depending on whose definition you are reading. It is Lamias or
lamiae in English.
A high proportion of the replies
demonstrated that the submitter had put
a large amount of thought, and sometimes research, into what was sent.
Thanks to all and keep them coming!
2007 is off to a good start.
This column is solely intended as a means of facilitating a general discussion regarding terminology choices.
For feedback regarding pressing terminology questions,

please try one of these online forums: Lantra-L
(www.geocities.com/athens/7110/lantra.htm),
ProZ.com (www.proz.com), or Translators Café
(http://translatorscafe.com).
Address your queries and responses to The
Translation Inquirer, 112 Ardmoor Avenue, Danville,
Pennsylvania 17821, or fax them to (570) 275-1477.
E-mail address: jdecker@uplink.net. Please make your
submissions by the first of each month to be included in
the next issue. Generous assistance from Per Dohler,
proofreader, is gratefully acknowledged.

Visit
www.atanet.org
twenty-four/seven
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Compiled by

Dictionary Reviews

Boris Silversteyn
bsilversteyn@comcast.net

How to Succeed as a
Freelance Translator
Author:
Corinne McKay
Publisher:
Translatewrite, Inc.
Publication date:
2006
ISBN:
978-1-4116-9520-7
Price:
$19.95
Number of pages:
141
Available from:
Corinne McKay
www.translatewrite.com

Reviewed by:
George Fletcher and Jonathan Hine
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Corinne McKay

has done a
fine job of gathering facts, data, and
real-life experiences and generously
sharing them with anyone the slightest
bit interested in the translation business. If you are thinking about
becoming a translator, this book will
either set you straight or launch you
successfully on your way. If you are
an established translator, interpreter,
or a translation company owner, this
book will improve your standing in
the profession, the quality of your
work, and your income. The following
review will outline the why and how
of the above statements; however, our
first recommendation to anyone
reading this is to run to your nearest
bookseller and get a copy before they
are all sold out.

the aspiring professional: 1) contract
(freelance) translator; 2) in-house
employee; or 3) translation agency
owner. We find in detail where the
jobs are and what they entail. A major
premise of the book is the need for
translators to see themselves as being
in business. Subsequently, the experience and advice imparted apply not
only to individuals, but to companies
as well.

Developing a Career

Beginning with the very first sentence, the challenge for any translator
or would-be translator is to put this
book down: “I decided to write this
book because I love my job, and
because so few bilingual people are
aware of the high demand for qualified translators and interpreters, or of
the lifestyle benefits of being a language entrepreneur.” Thus, we are
enticed into Corinne McKay’s journey
of becoming a professional translator.

Next, McKay unravels the mystery
of how professional translators set their
rates, with a list of websites to assist in
the process. This is followed by information about pertinent professional
associations for translators and interpreters and how to become certified.
We are now prepared to begin developing a translation career. Writing a
translation-specific résumé and cover
letter is outlined, and we proceed to
find our first client. Great detail is given
to this state of a nascent career. We then
learn how to build the business: whom
to contact and how. Setting up a home
office is discussed, including maximizing productivity. If you are a
working parent, you will discover how
to capitalize on the advantages of
working at home, with first-hand advice
from those who have gone before.

Introducing the Profession

Using the Right Tools

McKay’s first step in this journey is
to explain the difference between a
translator and an interpreter, and what
each does. (Although this review uses
the term “translator” throughout, most
of the information in the book also
applies to interpreters as well.)
Thereafter, we learn what it takes to
become a translator and how to hone
the necessary skills to succeed. Based
on personal experience and research,
McKay offers us a hand in defining
and exploring the three paths open to

Regardless of how knowledgeable
any individual reader may be in terms
of technology and translation memory
software and in setting up or upgrading
an office system, the next step in the
book will lead to many gems
embedded in the text for the taking.
Necessary office equipment is listed
and described, as well as the means of
organizing your business. If you have
heard of or ever wondered what the
meaning and functions of TRADOS,
SDLX, Déjà Vu, Wordfast, Heartsome,

Content
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OmegaT, Wordfisher, and Across are,
you will find out. You will also find out
if, how, and why any of these programs
are for you and, if so, the best computer
system to handle them.

The Legal Side
The legal side of operating a translation business is treated with an
entire chapter of its own. This section
begins with establishing your translation fees, beginning with minimums
and covering standard and discount
rates. If you have ever considered the
nuances of contracts and terms of
service, you may come out on the
other end of this reading with more
information than you thought existed
on this topic. What about collections
once the job is completed and
invoiced? McKay will not allow you
to fall into those infamous traps. You
will learn how to deal with a client
and head off any collection demons at
the pass before the job is completed
and delivered. Worst case scenarios?
You will be guided through arbitration
and dispute resolution, while maintaining your all-important cash flow.

Navigating the First Year
The last chapter will hold your
hand as your business grows through
the first year. Should you incorporate?
What is the difference between a Ccorporation, an S-corporation, a limited liability corporation, and sole
proprietorship? Read on! Taxes?
Learn what you need to know. We
reach the end of the last chapter with
point 10 of “10 ways to please a translation client.…Charge what you’re
worth and earn it.…Giving your
clients a little more effort than necessary proves to them that often, they
get the level of service they pay for.”
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Overall Evaluation
Thus concludes our journey with
Corrine McKay along her path to
becoming a successful professional
translator. Before these reviewers
could ever be convinced that establishing oneself as a professional translator is beyond any one individual’s
scope or ability, we would need to be
convinced that they had followed the
advice in this book first.
The icing on the cake is a list of
U.S. government agencies that
employ translators and interpreters,
lists of professional associations, and
institutions offering training programs
and home study courses. The book
ends with a glossary of translationrelated terms and an index for quick
reference to topics in the text.
At this point, a reviewer normally
finds what he or she considers a weak
point in the book to add balance to the
review. In this case, we will leave that
for you, the reader, to determine, if
you can, after you read this little jewel
of a book.

Additional Comments by
Jonathan Hine
Have you heard about the round
tuit? I am not talking about the square
one or elliptical one either. I have
wanted to get a round tuit for some
time, but Corrine McKay has written
the book for me.
Readers may be pleased to know
that the cost of How to Succeed as a
Freelance Translator is well worth it.
Essentially, it contains everything that I
was assembling for my own book, and
I am delighted that she has put together
such a fine product.
Corrine McKay’s book “suffers”
from only one thing, and that is its own
wealth of information. McKay has
done a masterful job getting so many
resources and links into such a small

package. Because she has, this has
become the kind of book that should
be updated every two or three years,
and I sincerely hope she does this.
I would also hope that in a future
version, she would cite or recognize all
her sources, both to support her
research and to introduce the reader to
other people with information on the
subject. Personally, I rely on such citations, so that I can look up other material that those authors may have written.
But what may be missing has no
effect on the value of the information
in this book. I encourage everyone to
buy it and reap the benefits.

George Fletcher, Ed.D., is president of Globe
Language Services, Inc. He is also an adjunct
associate professor of translation. He wrote The
Complete Handbook and Glossary of Soviet
Education; Chile: A Comparative Education Study;
and co-authored, along with the late Susana Greiss,
The Beginning Translator’s Survival Kit. Contact:
george@globelanguage.com.
Jonathan Hine is a member of ATA’s Italian and
French Language Divisions and the National Capital
Area Chapter of ATA. Besides translating and
interpreting full-time, he conducts business and
organization workshops. He also writes self-help
books and articles for language mediators. He
serves as a grader for ATA’s certification exam, a
mentor, and as secretary-treasurer of the American
Translation and Interpreting Studies Association.
Contact: hine@scriptorservices.com.
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Dictionary Reviews Continued

Chinese Business Dictionary
(English-Chinese)
American and Chinese
Business Terminology for the
Internet Age
Editors:
Morry Sofer (General Editor)
Richard Guo (Chinese Editor)
Publisher:
Schreiber Publishing
Publication date:
2005
ISBN:
0-88400-314-0
Price:
$24.95
Number of pages:
168
Available from:
www.schreiberlanguage.com
Reviewed by:
Frank Y. Mou
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The paperback

Chinese
Business Dictionary contains only a
little over 5,000 entries. At first, I could
not believe it was a dictionary because
the format was so unappealing, in that
the Chinese characters are in the wrong
font type and the font sizes vary.

Format
The dictionary is formatted into
two columns per page, with bold
typeface for the entries and regular
type for the translations. There is no
pronunciation information, nor any
cross references or indices. In addition, this dictionary does not offer any
appendices. One uncommon feature
of this dictionary is that there are no
subentries, resulting in numerous
entries for one word. For instance,
there are 38 entries for phrases
starting with the word “tax.”

Content
As many translators know, enormous changes have taken place
throughout the world, particularly in
China, in the past two decades.
Chinese↔English translators are
indeed scrambling to keep up with the
new terminology. Schreiber’s new dictionary seems to come at the right
time, and they are marketing it as a
dictionary that provides fully updated
business
terms
for
banking,
accounting, insurance, real estate,
import-export, taxes, business law,
computers, and more. The introduction to the dictionary states that this
new business dictionary is, “not tied to
the past but rather reflects the new
global economy.” Unfortunately, the
dictionary does not provide a comprehensive glossary in the above-mentioned fields. I could not find a
number of terms that I consider to be
essential in business circles,
including: Bretton Woods System;
crawling peg system; corporate gover-

nance; day trader; floor area ratio
(FAR); globalization; intellectual
property right; LIBOR rates;
NASDAQ;
New
York
Stock
Exchange; NAFTA; overnight rate;
six sigma; stakeholder; and tax haven.
These commonly used words are just
those off the top of my head; the list
can go on and on.
I have to admit that it may be too
harsh to demand that the glossary be
exhaustive. However, the translators
and editors should at least make the
dictionary and term translations concise and accurate. Unfortunately, I
found quite a few typographical errors
and mistranslations in this dictionary.
The introduction is obviously in
error when it refers to the dictionary
as “a new English-Russian business
dictionary.” The editor clearly overlooked the language combination
when copying the paragraph from the
introduction appearing in Schreiber’s
Russian version of this dictionary.

Quality of Chinese Translations
As far as the Chinese translations
are concerned, there are many entries
I feel obliged to disagree with. Below
are just a few examples under the
heading A:
Accounting rate of return has two
Chinese translations:
and
, where the latter
should be a Chinese term for “rate of
return on investment.”
Act of God comes with two Chinese
terms:
and
; the former
is a business term for force majeure,
which is not listed in the dictionary.
One of the translations for advance is
(loan), which would be better
rendered as
(lend).
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Affirmative action is mistranslated as
, when it should be
.
The Chinese translation for alienation
is a typo.
should be
.
Allegation should be
not
and
.

or

,

Allowance is mistranslated as
and
. It would be better translated
as
,
, and/or
.
Annuitant

is
mis-typed
. It should be

as
.

Content Recommendations
Some of the translations are very
loose. For instance, under the entry for
association, there are three Chinese
translations:
(association),
(public meeting, clearly a typo for
- trade union), and
(chamber of commerce).
On the other hand, a few definitions
are not inclusive enough. For example,
under the entry for peg, there is only one
Chinese translation,
(fix or fixing).
As the dictionary does not provide grammatical information, such as parts of
speech, it is difficult for users to figure
out whether this word can be used as a
noun or a verb, or even as an adjective.
Many of the dictionary’s terms are
not, as advertised, “explained in some
detail.” On the contrary, quite a few
entries are simply left up to the users
to discover the exact meaning. For
instance, the entry for NSF, translated
into Chinese as
, uses only
abbreviations. In addition to its
intended meaning of “not sufficient
funds,” NSF, in a business context,
could well mean National Science
Foundation, National Sex Forum,
Natural Suppressor Factor, National
Science Fair, Nuclear Strategic
Forces, or Nuclear Safety Facility.
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Therefore, acronyms or abbreviations
deserve more explanations for the
benefit of the users.
Other typos and mistranslations
include:
Term life insurance:
should be

,
.

Patent pending:
(patent
application), should instead be translated as
(under processing,
or waiting to be approved).
Mortgage has three Chinese translations:
(pawn),
(pledge),
and
(collateral rights), but the
most popularly used term is not
included:
. I would, therefore,
suggest that the terms, if there is more
than one translation under any entry,
be arranged in order, from the most
frequently used to the least, according
to the lexicography.
Listed under part-time is
, a
Chinese translation that is generally
used for “concurrently holding (a position).” I would suggest using
or
.
Initial public offering (IPO) is translated as
, which sounds literally like “primitive open stock.”
Instead, I would suggest using the established Chinese term
for
this entry.
Defined contribution pension plan is
mistranslated as
. It
would be better translated as
.
In his review of Schreiber’s
Multicultural Spanish Dictionary (The
ATA Chronicle, March 2003), former
ATA President Tom West speculated
that Schreiber’s practice is, “apparently to gin up a list of words in

English and then have translators
translate the list into” a foreign language. Tom correctly pointed out that,
“what Schreiber seems not to grasp,
however, is that words without context
are ambiguous.” Unfortunately, this
still holds true for the Chinese
Business Dictionary. For example,
within the context of government
bonds, none of the following three
entries for types of bonds bear connotations reflecting the term of maturity
of these bonds issued by the U.S. federal government: bill
,
note
, and bond
.

Overall Evaluation
Personally, I think that although
this dictionary may be useful for
Chinese students learning English, it
is certainly not designed with translators’ needs in mind. Furthermore, the
users should be informed that this dictionary has limited definitions, translations, or explanations, with only
about 5,000 entries, which is certainly
not very comprehensive.
Finally, it is my wish that Schreiber
Publishing consider adding more relevant entries with a CD-ROM to facilitate users’ searches for the appropriate
terms in their translation. If Schreiber
could add a reverse search feature
(i.e., by entering Chinese terms for
searching equivalent English terms), it
would be much appreciated. This
might help Schreiber to sell the dictionary more effectively.

Frank Y. Mou is an active member of ATA who has
served two terms as administrator of ATA’s Chinese
Language Division. He holds an M.A. in linguistics from
the University of Pittsburgh, where he taught Chinese
for three years. He is a full-time freelance
simultaneous interpreter and translator
(Chinese↔English) with 29 years of experience. His
expertise focuses on finance, law, medicine, as well as
auto, pharmaceutical, and steel industries. Contact:
Frank_Mou@yahoo.com.
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Humor and Translation

Mark Herman
hermanapter@cmsinter.net

But Was it Meant To Be Funny?

Is a big nose funny? A character

in John Hersey’s The Wall is said to be
a “parrot.” How about a bigger nose?
Edmond Rostand’s Cyrano de
Bergerac says that, when he goes
somewhere, his nose arrives 15 minutes before he does. How about an even
bigger nose? Berkeley Breathed’s cartoon penguin Opus has one ostensibly
the size of Massachusetts.
But what if the original authors did
not intend one or another of the above
to be funny? For whose sensibility
should the translator then translate:
the reader’s or the author’s?
Consider mangled metaphors. Some
are obviously intended to be funny:
“You could have knocked me over with
a fender!”(Jane Ace, from the 1930s
radio program The Easy Aces). Some
are probably not: “You took an oath to
defend our flag and our freedom, and
you kept that oath underseas and under
fire!” (George W. Bush, January 2006
speech to U.S. troops).
Double entendres are almost
always funny, regardless of the

author’s intent, as many a hastily
written newspaper headline illustrates: “Senator Says Recovery
Inevitable—More Lies Ahead.”
And then there are euphemisms,
discussed in Peter Unseth’s fine
article, “Watch Your Language!
Translating Euphemisms” (The ATA
Chronicle, February 2006). A
euphemism’s humor, or lack thereof, is
especially problematic because it
varies with the sensibility of the
reader. Are the much-used expressions
“mentally challenged” and “physically
challenged” ridiculous? I think so, but
many people do not. A far greater percentage of the English-speaking population probably considers “vertically
challenged” (meaning “short”) and
“horizontally challenged” (meaning
“fat”) to be funny. And “metabolically
challenged” is unfunny only to those
who cannot tolerate any humor on the
subject of death.
So what is a translator to do? There
are at least three ways to proceed. The
first is to be funny or not as the original

ATA Member Benefits
Collection Services/Receivables Management
Dun & Bradstreet
Mike Horoski
(800) 333-6497 ext. 823 7226
(484) 242-7226
michael.horoski@rmsna.com
www.rmsna.com
Credit Card Acceptance Program/
Professional Services Account
NOVA Information Systems
Reference Code: HCDA
(888) 545-2207 • (770) 649-5700
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writer intended, if that can be determined. The second is to translate for
someone with the same sensibility as
the original author’s audience (which is
not necessarily the sensibility of the
author), if that can be determined. And
the third, and most difficult, is to translate so as to elicit the same range of
reactions among likely readers of the
translation as was elicited among likely
readers of the original.
Who said translation was easy?

Herman is a librettist and translator.
Submit items for future columns via email to hermanapter@cmsinter.net or
via snail mail to Mark Herman, 1409
E Gaylord Street, Mount Pleasant, MI
48858-3626. Discussions of the translation of humor and examples thereof
are preferred, but humorous anecdotes
about translators, translations, and
mistranslations are also welcome.
Include copyright information and
permission if relevant.

For a complete list of benefits and more information, log onto www.atanet.org.

MasterCard
MBNA America
Reference Code: IFKV
(800) 847-7378 • (302) 457-2165
Life and Disability Insurance
Mutual of Omaha
(800) 624-5554 • (402) 342-7600
www.mutualofomaha.com

Overnight Delivery/Express Package Service
United Parcel Service (UPS)
Reference Code: C0000700415
(800) 325-7000
www.ups.com
Professional Liability Insurance
Hays Affinity Solutions (HAYS)
(866) 310-4297 • (202) 263-4016
cjones@hayscompanies.com
http://ata.haysaffinity.com
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2007 Honors and Awards

Alexander Gode Medal
The Alexander Gode Medal, ATA’s
most prestigious award, is presented
to an individual or institution for outstanding service to the translation and
interpreting professions. This award
may be given annually.

Eligibility
Individuals or institutions nominated do not have to be members of
ATA; however, a history of constructive
relations with ATA and the language
professions in general is desirable.
Nominees do not have to be U.S. citizens. Petitions and letter campaigns are
not encouraged.

Nominations
Nominations should include a sufficiently detailed description of the
individual’s or institution’s record of
service to the translation and/or interpretation professions to enable ATA to
draw up a meaningful short list for
approval by the ATA Board of
Directors.
Deadline: May 1, 2007

Award
Gode Medal, complimentary ATA
Annual Conference registration,
transportation to and from the confer-

ence, and up to four nights’ lodging at
the conference hotel.

Please send nominations of the
individual or institution you
consider worthy of receiving the
next Gode Medal to:
American Translators Association
225 Reinekers Lane, Suite 590
Alexandria VA 22314
Phone: (703) 683-6100
Fax: (703) 683-6122
Email: ata@atanet.org

Ungar German Translation Award
ATA invites nominations for the
2007 Ungar German Translation Award.
The award is bestowed biennially in
odd-numbered years for a distinguished
literary translation from German into
English that has been published in the
U.S. The next Ungar German
Translation Award will be presented at
ATA’s 48th Annual Conference in San
Francisco, California (October 31November 3, 2007).

Eligibility
To be eligible for the award, the
translation must be from German into
English and must have been published
in the U.S. in 2005 or 2006.
The published translation must list
the translator’s name on the title page
and preferably on the dust jacket.
Preference will be given to published
works that provide biographical information about the translator.
The translator does not have to be
an ATA member; however, the translator should have a strong connection
with the U.S. through citizenship or
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permanent residence. The nomination
must be submitted by the publisher of
the translated work.

Nominations
The nomination must be submitted
by the publisher of the work and must
include the following:

inal work. Please do not staple. If
providing a dual-language work,
copies are still required.
Deadline: May 1, 2007 (Publishers
are encouraged to submit nominations
early.)

Award
• Cover letter with complete publication information for the work
being nominated, including the
date of publication.
• Brief vita of the translator,
including place of residence and
contact information.
• Two copies of the nominated work
with one extra copy of the dust jacket.
• Two copies of 10 consecutive
pages from the original work,
keyed to the page numbers of the
translation. Please do not staple. If
providing a dual-language work,
copies are still required.
• Two copies of the translated pages
that correspond to the 10 consecutive pages provided from the orig-

$1,000, a certificate of recognition,
and up to $500 toward expenses for
attending ATA’s 48th Annual Conference in San Francisco, California
(October 31-November 3, 2007).

Please send nominations to:
Marilyn Gaddis Rose
Chair, ATA Honors & Awards
Committee
American Translators Association
225 Reinekers Lane, Suite 590
Alexandria VA 22314
Phone: (703) 683-6100
Fax: (703) 683-6122
Email: ata@atanet.org

➡
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2007 Honors and Awards Continued

Student Translation Award
In 2007, ATA will award a grant-inaid to a student for a literary or sci-tech
translation or translation-related project.
The award, to be presented at ATA’s
48th Annual Conference in San
Francisco, California (October 31November 3, 2007), is open to any graduate or undergraduate student, or group
of students, attending an accredited college or university in the U.S. Preference
will be given to students who have been
or are currently enrolled in translator
training programs. Students who are
already published translators are ineligible. No individual student may submit
more than one entry.
The project, which may be derived
from any facet of translation studies,
should result in a project with postgrant applicability, such as publication, a conference presentation, or
teaching material. Computerized
materials are ineligible, as are dissertations and theses. Translations must
be from a foreign language INTO
ENGLISH. Previously untranslated
works are preferred.

Applications
Applicants must complete an entry
form (www.atanet.org/membership/
honorsandawards_student_form.php)
and submit a project description not to
exceed 500 words. If the project is a
translation, the description must present
the work in its context and include a substantive statement of the difficulties and
innovations involved in the project and
the post-competition form the work will
take. The application must be accompanied by a statement of support from the
faculty member who is supervising the
project. This letter should demonstrate
the supervisor’s intimate familiarity with
the student’s work, and include detailed
assessments of the project’s significance
and of the student’s growth and development in translation.
If the project involves an actual translation, a translation sample of not less
than 400 and not more than 500 words,
together with the corresponding sourcelanguage text, must accompany the
application. The translation sample may
consist of two or more separate passages

from the same work. For poetry, the
number of words must total at least 300.
Deadline: April 17, 2007

Award
$500, a certificate of recognition,
and up to $500 toward expenses
for attending ATA’s 48th Annual
Conference in San Francisco,
California (October 31-November 3,
2007). One or more certificates may
also be awarded to runners-up.

Please send your applications to:
American Foundation for Translation
and Interpretation, Inc.
Columbia Plaza, Suite 101
350 E Michigan Avenue
Kalamazoo, MI 49007
Phone: (269) 383-6893
Fax: (269) 387-6333
E-mail: aftiorg@aol.com
Web: www.afti.org

S. Edmund Berger Prize for Excellence in Scientific and Technical Translation
ATA and the American Foundation
for Translation and Interpretation
(AFTI) invite nominations for the
annual S. Edmund Berger Prize.
The $1,000 prize is offered to recognize excellence in scientific and
technical translation by an ATA
member.
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Nominations
Individual translators or translation
companies wishing to nominate a
translator for this prestigious award
may obtain a nomination form from
the AFTI website (www.afti.org) or
from AFTI at the address listed below.
Nominations will be judged by a
three-member national jury. The recipient of the award will be announced
during ATA’s 48th Annual Conference
in San Francisco, California (October
31-November 3, 2007).

Deadline: September 18, 2007

Please send nominations to:
American Foundation for Translation
and Interpretation, Inc.
Columbia Plaza, Suite 101
350 E Michigan Avenue
Kalamazoo, MI 49007
Phone: (269) 383-6893
Fax: (269) 387-6333
E-mail: aftiorg@aol.com
Web: www.afti.org
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American Foundation for Translation and Interpretation
JTG Scholarship in Scientific and Technical Translation or Interpretation
This is a $2,500 non-renewable
scholarship for the 2007-2008 academic year for students enrolled or
planning to enroll in a degree program
in scientific and technical translation
or in interpreter training.

Eligibility
1. Applicants must be graduate or
undergraduate students enrolled or
planning to enroll in a program
leading to a degree in scientific and
technical translation or in interpretation at an accredited U.S. college
or university.
2. Applicants must be full-time students
who have completed at least one year
of college or university studies.
3. Generally, an applicant should
present a minimum GPA of 3.00
overall and a 3.50 in translationand interpretation-related courses.
4. Applicants should have at least one
year of study remaining in their
program; however, in certain circumstances, one residual semester
may be accepted.
5. Applicants must be U.S. citizens.

Selection Criteria
1. Demonstrated achievement in
translation and interpretation;
2. Academic record;
3. Three letters of recommendation by
faculty or nonacademic supervisor;
4. A 300-500-word essay outlining
the applicant’s interests and goals
as they relate to the field of translation or interpretation.

Application Process
1. Application forms may be obtained
by contacting the American
Foundation for Translation and
Interpretation at: Columbia Plaza,
Suite 101, 350 E Michigan Avenue,
Kalamazoo, MI 49007; or by
e-mail at aftiorg@aol.com.
2. Completed applications must be
received by AFTI by June 1, 2007.
3. A completed application consists of:
a) Application cover sheet;
b) Three letters of recommendation in a sealed envelope with
recommender’s signature over
the envelope flap;

c) Essay;
d) A copy of the applicant’s academic record with a copy of the
major/minor or other program
form, or a departmental statement of admission to the translation or interpretation program.

Award
A national award committee will
announce the name of the scholarship
award winner by the end of August
2007. The committee’s decision is
final. Disbursement of the award will
occur at the beginning of the Fall
Semester, 2007.

About JTG, Inc.
Founded in 1995 by ATA Past
President Muriel Jérôme-O'Keeffe,
JTG, Inc. is a language consultancy
that supports homeland security, intelligence, and global business with
cross-cultural communications. JTG,
Inc. has underwritten the AFTI scholarship since 2001. Visit: www.jtginc.com.

Harvie Jordan Scholarship
Purpose

Selection Criteria

Applications

To promote, encourage, and support leadership and professional
development of translators and interpreters within ATA’s Spanish Language Division (SPD) and to honor
Harvie Jordan’s lifetime contributions
as a language professional.

1. Demonstrated leadership skills and
career goals;
2. ATA Spanish Language Division
involvement and commitment to
service;
3. Special contributions to translation
and interpretation.

Description of Award

Please limit your response to each of
the selection criteria above to 100
words or less.

Applications are available at
www.afti.org. Send your completed
application via e-mail to the American
Foundation for Translation and
Interpretation at: aftiorg@aol.com.
Applications will be numbered, deidentified, and distributed to the
Scholarship Selection Committee.
The Selection Committee will consist
of members of ATA’s Spanish Language Division.
All selections are final. The
number of scholarships available will
depend on the funds available.
Scholarship winners will be asked to
contribute an article to Intercambios,
the SPD newsletter, reporting on the
conference or a session they attended.

Paid registration to ATA’s Annual
Conference or the SPD Mid-Year
Conference, as desired.

Eligibility
Limited to ATA Spanish Language
Division members in good standing
with two or more years of membership.

Deadline: September 18, 2007
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2007 Honors and Awards Continued

Alicia Gordon Award for Word Artistry in Translation
ATA invites nominations for the
2007 Alicia Gordon Award for Word
Artistry in Translation. This award
has been established in memory of
Alicia Gordon, known for creating
imaginative solutions to knotty translation problems based on rigorous
research. The award was established
by Alicia’s sister, Dr. Jane Gordon,
and award funds are administered by
the American Foundation for
Translation and Interpretation (AFTI).

Eligibility
The award is open to ATA members in good standing. Passages may
be submitted by the translators themselves or by others on their behalf.
The translation that, in the opinion of
the judges, demonstrates the highest
level of artistry in translation will
receive the award.

Submission Guidelines
1. Translations of up to 750 words
between (to or from) English and
Spanish or French in any subject
matter field will be considered.
2. The translation and the source text
must be submitted electronically by
June 1, 2007 to aftiorg@aol.com.

3. Only one submission per applicant
will be accepted. Submission of
more than one translation will
result in disqualification of the
applicant.
4. The translation must have been
done by an individual (no group
efforts).
5. If the translation was done as a
work for hire, the party that contracted for the translation must
consent in writing to its submission
for the award.
6. Former award recipients are
excluded from subsequent cycles.
7. The decision of the judges is final.
8. Applicants will be notified of the
judges’ decision with respect to
their submission. Notification will
be by electronic or other means as
determined by the committee of
judges.

10. The award will be announced at
ATA’s 48th Annual Conference in
San Francisco, California (October
31-November 3, 2007).
Deadline: June 1, 2007. (Candidates
are encouraged to submit nominations
early!)
Award: $250 and a certificate of
recognition

Please send nominations to:
Alicia Gordon Award for Word
Artistry in Translation
American Foundation for Translation
and Interpretation, Inc.
Columbia Plaza, Suite 101
350 E Michigan Avenue
Kalamazoo, MI 49007
Phone: (269) 383-6893
Fax: (269) 387-6333
E-mail: aftiorg@aol.com
Web: www.afti.org

9. By submitting a translation for
consideration,
the
applicant
expressly agrees to comply with
these guidelines.

Call for Submissions

Northern California Book Award in Translation
The Center for the Art of Translation is once again co-sponsoring the Northern California
Book Award in Translation for the best translation by a Northern California translator.
Please send recommendations of book-length translations from any language into English
(primarily fiction and poetry, though some nonfiction will be considered) published by
Northern California translators in 2006. The publisher does not have to be from Northern
California, but the translator must currently reside there. For more information, please
contact Olivia Sears at osears@catranslation.org.
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Upcoming Events
February 6-8, 2007

May 18-20, 2007

Israel Translators Association
Fifth International Conference
Haifa, Israel
www.ita.org.il

National Association of Judiciary
Interpreters and Translators
28th Annual Conference
Portland, Oregon
www.najit.org

March 2-3, 2007
California Healthcare Interpreting Association
7th Annual Educational Conference
San Jose, California
http://chia.ws/pages/index.php

March 8-10, 2007

May 31-June 3, 2007
ATA Medical Division
First Mid-Year Conference
Cleveland, Ohio

Transadaptation, Technology, and Nomadism
Concordia University
Montreal, Quebec, Canada
http://etfran.concordia.ca/conf07

July 28-29, 2007

April 11-15, 2007

October 31-November 3, 2007

Critical Link 5
“Quality in Interpreting:
A Shared Responsibility”
Sydney, Australia
www.criticallink2007.com

American Translators Association
48th Annual Conference
San Francisco, California
www.atanet.org

April 21-22, 2007

International Federation of Translators
XVIII World Congress
Shanghai, China
www.fit-ift.org

Institute of Translation and Interpreting
21st Birthday International Conference
London, England
www.iti.org.uk

INTERPRETA 2007
Buenos Aires, Argentina
www.interpreta2007.org

August 1-7, 2008

May 13-16, 2007
Society for Technical Communication
54th Annual Conference
Minneapolis, Minnesota
www.stc.org/cfp/cfp_GeneralInfo.asp

Scam Alert Websites
www.OnGuardOnline.gov
The Federal Trade Commission’s educational site about cross-border online fraud, offering information on
common scams and tips on how to avoid them.

www.tuesdayswithmantu.com
Contains information on Rich Siegel’s book, Tuesdays With Mantu: My Adventures With a
Nigerian Con Artist.
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DIRECTORY OF LANGUAGE SERVICES
To place an ad contact Matt Hicks at 215-321-9662, ext. 19 or mhicks@mcneill-group.com

The best professional
technical translations,
especially for Euro, African
and Brazilian Portuguese.
Quality, reliability, speed. Let us
help you optimize your project.

www.cybertecusa.com
800.769.7891
Fax 908.245.5434
mail@cybertecusa.com

7E THINK YOUR LANGUAGE

)NLINE 4RANSLATION 3ERVICES )NC
 7"ROADWAY 3TE s 'LENDALE #! 
  s INFO INLINELACOM
WWWINLINELACOM

To Advertise call Matt Hicks today
at 215-321-9662, ext. 19

Hindi, Gujarati <> English
Highly experienced, reliable. Awardwinner.
Professor. Designs translation courses.
www.proz.com/pro/9374 roomynaqvy@gmail.com
Customer Relations/Translation Manager

Customer Relations/Translation Manager sought
by Keihin Carolina System Technology, Inc. for
Tarboro, NC location. Must possess two (2) years
of experience in translating Japanese in a customerservice environment $36,192.00/ Year. Respond
to: Connie Hunt, Human Resources Manager,
ATTN: Requisition 2, Keihin Carolina System
Technology, Inc., 4047 McNair Road, Tarboro,
NC 27886. KCST is an EOE.

Spanish <> English
Reliable freelance translator with broad experience.
All work quality checked. chmilto@verizon.net.

South Asian Languages
Translation/Interpretation to/from Urdu, Hindi,
Punjabi, and English. Call 510-477-0730

Japanese Translator & Writer
Japanese Translator & Writer - fluent in Japanese
and English languages. Bachelor's required.
Send resume to MSI Resources, Inc. PO Box
4029, Oak Park, IL 60303.

ADVERTISE
IN ATA
& WATCH YOUR AD
TRANSLATE INTO $$$
Contact Matt Hicks today
for rates and information.
215-321-9662 ext. 19
mhicks@mcneill-group.com

If you have any
comments, please
email my manager…

Keith Laska
Vice President,
SDL TRADOS Technologies

I'm a customer, there may be times when I'd like to escalate
“ When
an issue, or even congratulate someone on a job well done.
It's not always that easy to do.
We want to make it easy for you to talk to us, and we want
to listen to your comments and feedback.
Therefore, we're changing the way we work with our customers
and how we work internally. This means a greater focus on
customer needs, and more importantly, creating a customer
experience that is rewarding at every encounter.
To enhance your interaction with us, we will be introducing
a number of initiatives that will culminate in 2007 becoming
the year of Global Customer Service.
This year, you'll be able to escalate issues directly to my
management team, and to me. You'll be able to post product
and service improvement ideas on a completely open online
forum. You'll even be giving our support engineers their annual
review. These and many other new initiatives are currently
being developed to enhance your customer experience
this year and beyond.

”

Why not start now? If you have any comments
on our level of customer service, please email
me at keithlaska@sdl.com.

To improve is to change. To be perfect is to change many times.
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